Instruction Manual
LNR400 Series







,,,

Instruction Manual
LNR400 Series

#L.X400021; r.29578/29578; en-US



Thank you for purchasing this product. Lorex is committed to providing our customers with a high quality,
reliable security solution.

This manual refers to the following models:
LNR408 (8-channel)
LNR416 (16-channel)

For the latest online manual, downloads and product updates, and to learn about our complete line of
accessory products, please visit our website at:

www.lorextechnology.com

RISK OF ELECTRIC SHOCK
DO NOT OPEN

WARNING: TO REDUCE THE RISK OF ELECTRIC SHOCK DO NOT REMOVE
COVER. NO USER SERVICEABLE PARTS INSIDE.

REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral
triangle, is intended to alert the user to the presence of uninsulated
"dangerous voltage" within the product’s enclosure that may be of
sufficient magnitude to constitute a risk of electric shock.

The exclamation point within an equilateral triangle is intended to
alert the user to the presence of important operating and
maintenance (servicing) instructions in the literature accompanying
the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS UNIT
TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF THE PLUG
TO THE WIDE SLOT AND FULLY INSERT.

#L.X400021; r.29578/29578; en-US



Table of contents

O A WDN

11

12

Important Safeguards ...........coiviiiiiisi 1
1.1 General PreCautions........c.ociuiiiiii e 1
1.2 Installation.........oo 1
1.3 1= VT 3
1.4 7= 3
LNR400 Series Features........ccociiiiiiiiiii i s ce s e s s s e e eaas 4
Getting Started (LNR400 Seri€S) .....ccvuruiirmirreiriniiinirne s rasnsanssanenss 6
Front Panel (LNR400 SerieS) .......cuuvruirurmimrmrreisrisresaressessssanssaens 7
Rear Panel (LNR400 Seri€S)....cccueuririrrrarrarirmansnasasrarasasesnsnssnsnsasasnrasass 8
Basic Setup (LNR400 Series) ......cccvruirurmimrmmreisirisrisa s sanssanens 9
6.1 Step 1: Connectthe IP Cameras ........cccoveiiiiiiiiiiiic e 9
6.2 Step 2: Connect the MOUSE........cuuvviiiiiiieie e 9
6.3 Step 3: Connect the EthernetCable ..., 9
6.4 Step 4: Connect the MONItOr.........oouiiiiiii e 10
6.5 Step 5: Connect the Power Adapter to Powerthe NVR...................... 10
6.6 Step 6: Upgrade Firmware to Latest Version (if Available) .................. 10
6.7 Step 7: Verify Camera lmage .........o.oveiiiiiiiiiiice e 11
6.8 Step 8: Setthe TiMe ... 11
6.9 Default System Password & Port Numbers .............c.coociiiiiiiiiineni. 11

6.9.1  FLIR CloUud™ ..o e 11
6.10  Quick Access to System Information ............coocviiviiiiiiiiiiiinen, 12
6.11  Connecting Cameras to the Local Area Network (LAN) ..................... 13
MOUSE CONLION .....ceieiiiieiiiii i e e s e 16
Using the System ..o 17
8.1 ON-SCreen DiSPlay .....c.euieiiiei e 17
8.2 Using the QUICK MENU...........iiiiiiii e 18
8.3 Adjusting Camera Image Settings...........cooviiiiiiiiiiieeen 18
8.4 Using the Navigation Bar ... 20
8.5 Using the Camera Toolbar ...........ooooiiiiiiiiiiii e 20

8.5.1 Using Quick Playback .............ccooeiiiiiiiiiiiiiiie 20

8.5.2 Using Digital Zoom in Live Display ............cccoveiiiiniiinnennn. 21

8.5.3 Using Real-time Backup ...........cccoveiiiiiiiiiiiiiieen 21
8.6 Using the Virtual Keyboard.............cccoiiiiiiiiii e 21
8.7 Adjusting Camera Zoom & FOCUS ...........oeuiiiiiiiiiiiiiieeeeeeea 22
Setting The TiMe ..o s e 23
=TT o] ' |13 T TR 24
10.1  Video Recording TYPES ....cueuiniiiiiie et 24
10.2  Main Stream and Sub Stream...........coiiiiiiiiii 24
10.3  Setting up Scheduled or Manual Recording ............cccocveviiiiiiiiiannnn. 24
10.4  Configuring Hard Drive OVerwrite .........c.coooiiiiiniiiiiiiiee 25
Search (Playback) ..........coiiiiiiiiiiiiiiir e 26
11.1  Playing Back Video from the Hard Drive..........c.ccoooiviiiiiiniien, 26
11.2  Playback CoNtrols........ovuiiniiiiiiiice e 27
11.3  Playing Back from a USB Drive ...........cccciiiiiiiiiiiiee, 27
11.4  Using Smart SEarch .........coovvuiiiiiiiiiii e 28
[ =T (1 ] o T, 30
12.1  Formatting the USB Thumb Drive .........c.ccoiiiiiiiiiiiiiee 30
122 Backing UP VIdEO......cviiiiii e 31
12.3  Using Video Clip BACKUP ... cueviiiiiiiieee e 31

#L.X400021; r.29578/29578; en-US \%



Table of contents

13

14

12.4  Viewing Backup Files... ..o 32
12.4.1 Viewing Backup FilesonPC ..........ccoooviiiiiiiiii, 32
12.4.2 Viewing Backup FilesonMac ............coooviiiiiiiiiii, 35
Managing Passwords and User Accounts...........coieveiriiiriecrnnreninnanenss 38
13.1  Changing PassWords............cicuviuiiiiieiieee e 38
13.2  AdAING USEIS ... ettt 39
13.3  MOdIfyiNG USEIS ...t 39
13.4  Deleting USErS . ..ovei e 40
13.5  ACCOUNE GIOUPS ..cvienitiiiieiee ettt e 40
13.6  AddING GrOUPS .. ceuiiiiiiie et 40
13.7  MOdifying GrOUPS .. .ucvieniiieeeiee et e 41
13.8  Deleting GroUPS ....c.uceiiieiiiiiiee e 41
Using the Main Menu .........cccoiiiiiiiiiini s s e 42
141 CAIMEIA ...inieiiii e 42
14.1.1 Remote DeVICe .......cviiiiiiiie e 42
14.1.2 Viewing Camera Status .........c.covviiiiiiiiiii e 43
14.1.3 Viewing Camera Firmware VErsions ..............cccovevininieninnen. 43
14.1.4 Upgrading Camera Firmware .............ccocoviniiniiiiiiieeeeneen, 43
14.1.5 ReCOrding.......cocuiiuiiiii e 44
14.1.6 Configuring Recording Quality .............cooveviiiiiiiiiiiiiiinnn, 44
14.1.7 Configuring Snapshot Recording Settings..............ccccceeunee. 45
14.1.8 Creating Custom ChannelNames...............ccccceeiiiiiiiiin. 46
T14.2 N0 48
14.2.1 HDD INfO couiitii e 48
14.2.2 Record INfO.....oeuieiiii 48
T14.2.3 VEISION ..oieiitiii e 49
14.2.4 EVentINfO ..ot 49
14.2.5 ONNNE USEIS ..c.iiviiiiiii e 50
14.2.6 LOAd. ... i 50
14.2.7 TSt 51
14.2.8 BPS .o 51
T4.2.9 LOg - iuiiiiii it 51
143 SeHING. . ce it 53
14.3.1 NEIWOIK .. cve e 53
14.3.2 Selecting DHCP or Static IP Address (TCP/IP) .........c.ccceue.... 53
14.3.3 Configuring System Ports (Connection)..............ccccoveiennen. 54
14.3.4 Configuring DDNS Settings .........cocoviiiiiiiiiiiiieee, 55
14.3.5 Configuring Email Alerts ............ccocoiiiiiiiiniiiiiieeeee, 55
14.3.6 Configuring Switch Settings (Advanced)..............ccoveviennnnen. 57
14.3.7 BVeNt...o 58
14.3.8 Configuring Motion Detection.............ccoovviiiiiiiiiiie, 58
14.3.9 Configuring Video Loss Settings.........ccooveiiiiiiiiiiiiniiinnn, 60
14.3.10 Configuring Alarm Input Devices...........ccooviiiiiiiiiiiiienenn. 61
14.3.11 Controlling Alarm Output Devices .............cocveeiiiiiiiininnnnn. 62
14.3.12 Configuring Hard Drive Warnings...........cocoevieeiieiineneenennen. 63
14.3.13 Configuring Network Warnings .............covvviiiiiniiiiiininenenn, 63
T4.3. 14 8t0ra0C ... .e et 64
14.3.15 Configuring the Video Recording Schedule.......................... 64
14.3.16 Configuring Pre-Recording............ccooviiiiiiiiiiiii, 65
14.3.17 Configuring the Snapshot Schedule ...............c.cooiiiininne. 66

#L.X400021; r.29578/29578; en-US Vi



Table of contents

15

16

17

14.3.18 Configuring Holidays ..........c.coeiiiiiiii e 66
14.3.19 Formatting the Hard Drive .............coooiiiiiiiii, 67
14.3.20 Configuring Hard Drive TYype ........ovoiviiiiiiiiiieieeeeee 68
14.3.21 Setting up Hard Drive Mirroring (Advanced) ...............c.cceeeen. 68
14.3.22 Configuring Hard Drive Groups (Advanced) ............c.cceeueenen. 70
14.3.23 Configuring General System Settings .............ccoeviiiiiiiennen. 71
14.3.24 Setting the Monitor Resolution (Display) ..........c.ccocoveiinieninnen. 72

14.3.25 Saving Your System Configuration to a USB Thumb
DIV e 73
14.3.26 Setting the System to Factory Defaults................ccccoeieinnen. 74
14.3.27 Upgrading Firmware from USB...........c..ccooiiiiiiiiiiini, 75
144 ShUIAOWN. ...ttt 77
Connecting to Your System Over the Internet on PC or Mac.................... 78
15.1  System RequireMents.........ccuiiuiiiiiiiee e 78
15.2  Step 1 of 3: Connect your System to Your Router...............ccoceeennnnn. 78
15.3  Step 2 of 3: Obtain the system’s Device ID.............ccocovviiiiiiiiiiiinnn. 79
15.4  Step 3 of 3: Connect to the System Over the Internet ........................ 79
Using FLIR Cloud™ Client for PC or Mac ........c..cccvriiiiiirnecrnnrenesanenss 83
16.1  HOME PAQE ... 83
16.2  LIVE VIBW ettt 83
16.2.1 Live View CONtrolS.......cvuiiniiiiiii e 84
16.2.2 Opening Live View in Multiple Monitors ...............cooovvieinnen. 85
16.3  Controlling PTZ Cameras .........ccuveiuiiiiiiiiiiiee e 86
16.3.1 PTZ Presets. ..o 87
16.3.2 PTZTOUMS. . oottt 88
16.3.3 PTZPattern .......cooiniiiiii e 89
16.3.4 PTZ SCaN .. .uitiiii e 90
16.3.5 PTZPaN. ..o 90
16.4  Playback. ... ..o 90
16.5  Playback CONtrols....... .o 92
16.6  Downloading Video to your Computer Hard Drive................cccccenn.e. 93
16.7  AlAIM e 94
16.8 L0 it 95
16.9  Eomap e 96
T16.10  DBVICES ...ttt 98
16.11  Device COoNfig ...uvvnieeieii e 99
16.12  AlarmM CFG ... 99
16.13  TOUM & TASK .oviiviiiciei e 102
16.14  ACCOUNT ..ot e 103
16.14.1 Managing User ACCOUNtS............ccocoviviiiiiiiiiiiiiiiieeen 103
16.14.2 Managing RoIES. ........ociviieii e 105
16.15  GENEIAl ...eeie e 106
16.15.1 BASIC .. euieiiiiiii et 106
16.15.2 I8 ..o 106
16.15.3 Alarm Prompt ..o 107
16.15.4 VEISION ...oviiiiiii e 108
Connecting to your System Using Smartphone or Tablet Apps.............. 109
171 PRONE. .. 109
17.1.1 PrerequIsites ... ..o.veieiiii e 109
17.1.2 Connecting to your System oniPhone...............cccoveiienenne. 109
17.1.3 Live View Interface ...........ooiiiiiiiiii 110

#L.X400021; r.29578/29578; en-US Vii



Table of contents

18

19

17.1.4 Controlling PTZ Cameras..........cccveuviuiiinieiiiiiiieieieeeens 111
17.1.5 Viewing Snapshots and Videos with Local Files .................. 112
17.1.6 Using Playback Mode oniPhone .............c.cooiiiiiiiiiinnns 113
17.1.7 Enabling Push Notifications .............ccooviiiiiiiiii, 114
17.1.8 Usingthe EventList..........cooiiiiiie 116
17.1.9 USINg FaVONteS ......ceiiiiii e 117
17.1.10Usingthe E-Map ....c.oviniii e 118
17.1.11 Device Manager..........coeuvieieiiiie e 120
17.1.12 Adding Devices Using an IP or DDNS Address
(ADVANCEA) ...t 121
172 PAA e 122
17.2.1 PrerequISites ... ..c.veieiiii e 122
17.2.2 Connecting to your systemonaniPad ..............c..ccoceeeenne. 122
17.2.3 Live View Interface ...........cooviiiiiiiii 123
17.2.4 Controlling PTZ Cameras...........cocveiiiieiiiiniiiciieeeeeen 124
17.2.5 Using Playback Mode oniPad.............c.coooiiiiiiiiniiinnns 125
17.2.6 Using Local File to View Manual Recordings ...................... 127
17.2.7 Enabling Push Notifications .............ccooviiiiniiiiiin, 128
17.2.8 Usingthe Event List..........cooviiiiiiii e, 130
17.2.9 USINg FaVOIIteS ..o 131
17.210Usingthe E-Map ... 132
17.2.11 Using the Device Manager ............ccocovveiiiiniiiiiiieeee 134
17.2.12 Adding Devices Using an IP or DDNS Address
(ADVANCEA) ...t 134
17.3  ANAIOId ..o 136
17.3.1 Prerequisites ... .....oveiviniiiie 136
17.3.2 Connecting to your System on Android ............occevenienennen. 136
17.3.3 Live View Interface .........cocooeviiiiiiiiii 137
17.3.4 Controlling PTZ Cameras..........ccovuviiiiiiiiiiiiiicineeeen 138
17.3.5 Viewing Snapshots and Videos with Local Files .................. 139
17.3.6 Using Playback Mode on Android ...............cocoiiiiiiniiinnn, 139
17.3.7 Enabling Push Notifications .............ccooviiiiiiiiiiin, 141
17.3.8 Usingthe Event List........cccooeiiiiiii e, 142
17.3.9 Using Favorites..........cooeveiiiiiiii e 142
17.3.10Usingthe E-Map ..o 144
17.3.11 Device Manager.........cceuviiieiiiiieee e 145
17.3.12 Adding Devices Using an IP or DDNS Address
(ADVANCEA) ..ot 146
DDNS Setup (Advanced) .......cccoiveureirurierirrrsrir s e raea 147
18.1  Accessing your System within a Local Network (LAN) ..................... 147
18.1.1 Step 1 of 3: Connect your System to Your Router ................ 147
18.1.2 Step 2 of 3: Obtain the System’s Local IP Address............... 148
18.1.3 Step 3 of 3: Connect to the System’s Local IP
AAIESS .o e 148
18.2 DDNS Setup—Access your System Remotely over the
101 (=11 0= S PP PPPP 150
18.2.1 Step 1 0of 4: Port Forwarding ..........ccoouveiiieiiiniiiiiiiieens 151
18.2.2 Step 3 of 4: Enable DDNS on the System ...............cccoene. 151
18.2.3 Step 4 of 4: Connect to the System’s DDNS Address ........... 151
Connecting a PTZ Camera (LNR400 Series)........ccvruirrmimrneranenranensa 155
19.1  Controlling a PTZ Camera (Local NVR) .........cccooeiiiiiiiiiiiiiinenn, 155

#L.X400021; r.29578/29578; en-US viii



Table of contents

20

21

22
23

24

19.2  Advanced PTZ CONMrolS .......c.oeuiuiiiieieiee e 156
19.2.1 PreSelS cooieii i 157
19.2.2 TOUIS et 157
19.2.3 Pattern. ... 158
19.2.4 AULO SCAN ....oiviiiiiiiiii e 158
LNR400 Series Hard Drive Installation..............ccoeviiiiiiiiic e, 160
20.1  InstallingaHard Drive...........cocoiiiiiiiii 160
20.2 Removingthe Hard Drive..........cccoviiiiiiiii e 161
20.3 Formatting Hard DIriVes ..........couiiiiiiiiiee e 162
Recording AUdiO ........cueuiuieieiiininir s s 164
21.1  Step 1 of 2: Connecting an audio-capable camera ......................... 164
21.2  Step 2 of 2: Configuring audio recording ...........ccoveveiiiiiiineneeninnnn. 165
Troubleshooting ........ccveiiiiiiiiiiir e 166
LNR400 Series System Specifications...........ccccovviiiiiiiiiiiiiiiiincenenns 168
2831 Y S BIM i 168
23.2  INPUES/OULPULS ...eieieeieieiece e 168
23.3  DISPIAY ..ot 168
23.4  RECOIAING «.ueneeniie et 168
23.5 Playbackand Backup ...........coieiiiiiiiiiii e 169
23.6  Storage & ArChive ..........oeieiii i 169
23.7  CONNECHVITY. . eueiiiii e 169
23.8  GBNEIAl e 170
23.9  Recording Resolution (Pixels) & Speed (FPS — Frames per
SECONA) ..ttt 170
NOTICES. .. et e e 171
241 FCC/C NOCE. ... ettt 171
242  MOAIfICAtION ...ttt 171
24.3  ROHS ... e 171

#L.X400021; r.29578/29578; en-US ix






Important Safeguards

In addition to the careful attention devoted to quality standards in the manufacturing proc-
ess of your product, safety is a major factor in the design of every instrument. However,
safety is your responsibility too. This sheet lists important information that will help to en-
sure your enjoyment and proper use of the product and accessory equipment. Please read
them carefully before operating and using your product.

1.1 General Precautions

1. All warnings and instructions in this manual should be followed.

2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents.
Use a water-dampened cloth for cleaning.

3. Do not use this product in humid or wet places.

4. Keep enough space around the product for ventilation. Slots and openings in the stor-
age cabinet should not be blocked.

5. ltis highly recommended to connect the product to a surge protector to protect from
damage caused by electrical surges. It is also recommended to connect the product to
an uninterruptible power supply (UPS), which has an internal battery that will keep the
product running in the event of a power outage.

/\  CAuTION

Maintain electrical safety. Power line operated equipment or accessories connected to this product
should bear the UL listing mark or CSA certification mark on the accessory itself and should not be modi-
fied so as to defeat the safety features. This will help avoid any potential hazard from electrical shock or
fire. If in doubt, contact qualified service personnel.

1.2 Installation

1. Read and Follow Instructions - All the safety and operating instructions should be
read before the product is operated. Follow all operating instructions.

2. Retain Instructions - The safety and operating instructions should be retained for fu-
ture reference.

3. Heed Warnings - Comply with all warnings on the product and in the operating
instructions.

4. Polarization - Do not defeat the safety purpose of the polarized or grounding-type
plug.
A polarized plug has two blades with one wider than the other.

The wide blade or the third prong are provided for your safety.

If the provided plug does not fit into your outlet, consult an electrician for replacement
of the obsolete outlet.
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Important Safeguards

10.

11.

12.

13.

14.

15.

16.

Power Sources - This product should be operated only from the type of power source
indicated on the marking label. If you are not sure of the type of power supplied to your
location, consult your video dealer or local power company. For products intended to
operate from battery power, or other sources, refer to the operating instructions.
Overloading - Do not overload wall outlets or extension cords as this can result in the
risk of fire or electric shock. Overloaded AC outlets, extension cords, frayed power
cords, damaged or cracked wire insulation, and broken plugs are dangerous. They
may result in a shock or fire hazard. Periodically examine the cord, and if its appear-
ance indicates damage or deteriorated insulation, have it replaced by your service
technician.

Power-Cord Protection - Power supply cords should be routed so that they are not
likely to be walked on or pinched by items placed upon or against them. Pay particular
attention to cords at plugs, convenience receptacles, and the point where they exit
from the product.

Surge Protectors - It is highly recommended that the product be connected to a
surge protector. Doing so will protect the product from damage caused by power
surges. Surge protectors should bear the UL listing mark or CSA certification mark.
Uninterruptible Power Supplies (UPS) - Because this product is designed for con-
tinuous, 24/7 operation, it is recommended that you connect the product to an uninter-
ruptible power supply. An uninterruptible power supply has an internal battery that will
keep the product running in the event of a power outage. Uninterruptible power sup-
plies should bear the UL listing mark or CSA certification mark.

Ventilation - Slots and openings in the case are provided for ventilation to ensure reli-
able operation of the product and to protect it from overheating. These openings must
not be blocked or covered. The openings should never be blocked by placing the prod-
uct on a bed, sofa, rug, or other similar surface. This product should never be placed
near or over a radiator or heat register. This product should not be placed in a built-in
installation such as a bookcase or rack unless proper ventilation is provided and the
product manufacturer’s instructions have been followed.

Attachments - Do not use attachments unless recommended by the product manu-
facturer as they may cause a hazard.

Water and Moisture - Do not use this product near water — for example, near a bath
tub, wash bowl, kitchen sink or laundry tub, in a wet basement, near a swimming pool
and the like.

Heat - The product should be situated away from heat sources such as radiators, heat
registers, stoves, or other products (including amplifiers) that produce heat.
Accessories - Do not place this product on an unstable cart, stand, tripod, or table.
The product may fall, causing serious damage to the product. Use this product only
with a cart, stand, tripod, bracket, or table recommended by the manufacturer or sold
with the product. Any mounting of the product should follow the manufacturer’s instruc-
tions and use a mounting accessory recommended by the manufacturer.

Camera Extension Cables — Check the rating of your extension cable(s) to verify
compliance with your local authority regulations prior to installation.

Mounting - The cameras provided with this system should be mounted only as in-
structed in this guide or the instructions that came with your cameras, using the pro-
vided mounting brackets.
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Important Safeguards

17. Camera Installation - Cameras are not intended for submersion in water. Not all cam-
eras can be installed outdoors. Check your camera environmental rating to confirm if
they can be installed outdoors. When installing cameras outdoors, installation in a
sheltered area is required.

1.3 Service

1. Servicing - Do not attempt to service this product yourself, as opening or removing
covers may expose you to dangerous voltage or other hazards. Refer all servicing to
qualified service personnel.

2. Conditions Requiring Service - Unplug this product from the wall outlet and refer
servicing to qualified service personnel under the following conditions:

* When the power supply cord or plug is damaged.

* If liquid has been spilled or objects have fallen into the product.

* |f the product has been exposed to rain or water.

¢ If the product has been dropped or the cabinet has been damaged

* |f the product does not operate normally by following the operating instructions. Ad-
just only those controls that are covered by the operating instructions. Improper ad-
justment of other controls may result in damage and will often require extensive
work by a qualified technician to restore the product to its normal operation.

* When the product exhibits a distinct change in performance. This indicates a need
for service.

3. Replacement Parts - When replacement parts are required, have the service techni-
cian verify that the replacements used have the same safety characteristics as the orig-
inal parts. Use of replacements specified by the product manufacturer can prevent fire,
electric shock, or other hazards.

4. Safety Check - Upon completion of any service or repairs to this product, ask the
service technician to perform safety checks recommended by the manufacturer to de-
termine that the product is in safe operating condition.

1.4 Use

1. Cleaning - Unplug the product from the wall outlet before cleaning. Do not use liquid
cleaners or aerosol cleaners. Use a damp cloth for cleaning.

2. Product and Cart Combination - When product is installed on a cart, product and
cart combination should be moved with care. Quick stops, excessive force, and un-
even surfaces may cause the product and cart combination to overturn.

3. Object and Liquid Entry - Never push objects of any kind into this product through
openings as they may touch dangerous voltage points or “short-out” parts that could
result in a fire or electric shock. Never spill liquid of any kind on the product.

4. Lightning - For added protection of this product during a lightning storm, or when it is
left unattended and unused for long periods of time, unplug it from the wall outlet and
disconnect the antenna or cable system. This will prevent damage to the product due
to lightning and power line surges.
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LNR400 Series Features

Features

* Full high definition 1080p recording.

* Real-time recording at 30fps per channel.

¢ 8 Built in PoE (Power Over Ethernet) ports providing video and power on a single Ether-
net cable.

e Automatically detects compatible IP cameras in the network.

e 24/7 security-grade hard drive2.

e H.264 video compression2.

* Expandable High Capacity Storage up to 8TB (max 2x4TB HDD).

e Mirror Hard Drive Recording - secure your recordings by backing up footage to an inter-
nal hard drive at the same time as recording to the primary hard drive3.

¢ Pentaplex operation - view, record, playback, backup & remotely control the system
simultaneously.

e Simultaneous playback and live view on the same screen4.

* Selectable area digital zoom in live view and playback.

* Dynamic click-and-drag camera channel assignment.

* Flip and mirror camera view settings.

* Convenient front panel button controls.

¢ Accurate time stamps with NTP & daylight savings time.

¢ Instant USB backup of live video from selected camera.

e 2video outputs (HDMI & VGA) to connect multiple monitors.

e HDMI cable included for simple connection to HD TVs.

* Keep up to date with automatic firmware upgradess.

» 3-Step remote view with FLIR Cloud™s,

¢ PC and Mac compatible?.

* Free iOS and Android compatible apps with live viewing, playback, video recording,
and snap shot”.

¢ Dedicated iPad app with multi-channel live viewing and playback.

* Push notifications of motion events.

¢ [nstant email alerts with snap shot attachment.

¢ Dual streaming to conserve bandwidth.

* Continuous, scheduled and motion recording.
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LNR400 Series Features

E

NOTE

7.

Compatible with select Lorex 1080p wired PoE HD cameras only. For a list of compatible cameras,
please visit www.lorextechnology.com/support

Recording time may vary based on recording resolution & quality, lighting conditions and movement
in the scene.

Mirror recording requires a second hard drive (not included) to be installed in the NVR. Mirrored hard
drive must be as large or larger than the primary hard drive to backup all recordings. Backup begins
from when the mirrored hard drive is installed and configured.

Instant playback feature available on one camera at a time during live view when in quad or multiple
camera viewing mode.

The NVR firmware and software must be upgraded to the latest version to use the FLIR Cloud™
service. When the system is connected to the Internet, it will automatically alert you if there is a firm-
ware upgrade available.

Requires a high speed internet connection and a router (not included). A minimum upload speed of
1Mbps is required for the best video performance. Up to 3 devices may connect to the system at the
same time.

For the latest list of supported apps and devices, please visit www.lorextechnology.com/support

Use product in accordance with the instructions provided. All trademarks belong to their respective own-
ers. No claim is made to the exclusive right to use the trademarks listed, other than the trademarks owned
by Lorex Corporation. We reserve the right to change models, configurations or specifications without no-
tice or liability. Product may not be exactly as shown. Images are simulated.
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Getting Started (LNR400 Series)

The system comes with the following components:

; Remote control
NVR (Network Video Recorder) AC power cable (may not be exactly as shown)

\

USB mouse Ethernet cable HDMI cable

Quick start guides

Hard drive size, number of channels, and camera configuration may vary by model. Please
refer to your package for specific details. Check your package to confirm that you have re-
ceived the complete system, including all components shown above.
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Front Panel (LNR400 Series)

N oM

. IR receiver and LED indicators: IR receiver for the remote control. Keep the IR re-
ceiver clear from obstructions.

¢ Channel Indicators: Glow when camera is connected to the corresponding
channel.

¢ NET: Glows when network is in normal state. Turns off for network error.

¢ HDD: Glows to indicate hard drive is in normal state. Turns off when there is a hard
drive error.

Playback buttons:
. H Previous file: Press to skip to the previous video file on the system.

u Next file: Press to skip to the next video file on the system.

-
o Slow: Press to slow playback / decrease playback speed.

u Fast: Press to speed up playback / increase playback speed.
. n Play backwards: Press to play video backwards / pause video.

. u Play: Press to play video / pause video.

SHIFT: During text input, press to switch input types.

REC: Press to open manual recording controls.

FN: Performs special functions in some menus.

ESC: In menus, press to go back / exit menus. In playback, press to return to live view.

Directional buttons:

. ‘_I: From live view, press once to open the System Information screen. In menus,
press to confirm menu options.

* Directional buttons: Press to move cursor in menus. In live view, press up to
change split screen layout; press left / right to select channels when single-channel
mode is selected.

USB port: Connect a USB mouse (included) or connect a USB thumb drive (not in-
cluded) for data backup or firmware upgrades.

Power button: Press and hold to power off the system (system password required).
Press to power the system back on.
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Rear Panel (LNR400 Series)

@~

No o~

8.

9.

. Power input: Connect the included AC power cable.

On / Off switch: Turns the NVR on or off.

PoE Ports: Connect IP cameras. Integrated PoE (Power Over Ethernet) ports provide
power to cameras and video connection to NVR.

RS232: Service only; not supported.

VGA: Connect a VGA monitor (not included) to view the system interface.

Audio IN/Audio OUT: Service only; not supported.

USB port(s): Connect a USB mouse (included) or USB thumb drive (not included) for
data backup or firmware updates.

HDMI: Connect to an HDMI monitor or TV (not included) to view the system interface.
LAN: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.

10. Alarm block: Connect alarm/sensor devices (not included).
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Basic Setup (LNR400 Series)

6.1 Step 1: Connect the IP Cameras
Option 1: Direct Connection to NVR

e Connect cameras to the PoE Ports on the rear panel of the NVR using Cat5e or higher
grade Ethernet cable. The cameras will appear on the NVR without any additional con-
figuration when the system starts up.

@ NOTE

Compatible with select Lorex 1080p wired PoE HD cameras only. For a list of compatible cameras,
please visit www.lorextechnology.com/support

Connect IP cameras directly to PoE ports.

Option 2: Connect Cameras to Local Network

You can also connect your IP cameras to your local network for flexible installations. You
will need to do this to connect cameras 9~16 to 16—channel models. For details, see 6.11
Connecting Cameras to the Local Area Network (LAN), page 13.

6.2 Step 2: Connect the Mouse

¢ Connect a USB mouse (included) to one of the USB ports.

6.3 Step 3: Connect the Ethernet Cable

* Connect an Ethernet cable (included) to the LAN port on the rear panel of the system.
Connect the other end of the Ethernet cable to a router on your network.
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Basic Setup (LNR400 Series)

6.4 Step 4: Connect the Monitor

* Connect the included HDMI cable from the HDMI port to the TV or monitor
(recommended).
OR

¢ Connect a VGA cable (not included) from the VGA port to the monitor.

1. VGA port.
2. HDMI port.

6.5 Step 5: Connect the Power Adapter to Power the NVR

e Connect the included AC power adapter to the NVR and connect the other end to a
power outlet or surge protector. Then turn the power switch to | to power on the NVR.

At startup, the system performs a basic system check and runs an initial loading sequence.
After a few moments, the system loads a live display view.
6.6 Step 6: Upgrade Firmware to Latest Version (if Available)

If a firmware upgrade is available, you will be asked to install it once the system starts up.
It is required to upgrade your system firmware and client software or mobile apps to the lat-
est version to enable remote connection to the system.

If a firmware upgrade is available:

1. After startup, a notification will appear asking you to upgrade the firmware. Click OK to
upgrade.
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Basic Setup (LNR400 Series)

2. Enter the system user name (default: admin) and password (default: 000000) and
click OK. Wait for the firmware update to complete. The system will restart once the
firmware has been upgraded.

& WARNING

DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING FIRM-
WARE INSTALLATION

6.7 Step 7: Verify Camera Image

* Power on the cameras, and then verify the camera video quality before mounting the
cameras to a permanent location.

* Mount the cameras under a sheltered location. Always verify the outdoor rating of your
camera before installing it in a permanent location.

6.8 Step 8: Set the Time

* Set the system time and date for accurate video time stamps. Videos with inaccurate
times may not be valid as surveillance evidence.
* For details on setting the system time, see 9 Setting The Time, page 23.

6.9 Default System Password & Port Numbers

/\  caution

By default, the system user name is admin and the password is 000000. It is essential that you create
your own password. For details, see 13 Managing Passwords and User Accounts, page 38.

The system requires a user name and password to log in to the system remotely using a
computer or mobile device. After logging on remotely the first time, you will be asked to
create a custom password for the system.

Local system and remote connectivity (LAN & Internet) user name and password:

e Username: admin
e Password: 000000

Default ports for DDNS remote access:
e Port 80 (HTTP port)

¢ Port 35000 (Client port)

6.9.1 FLIR Cloud™

This system features the exclusive FLIR Cloud™. This is a cloud service that allows you to
connect to your system over the Internet via a secure handshake with our servers. This
means you can easily connect to your system without requiring any network configuration.

For details on setting up your system to connect to the Internet using FLIR
Cloud™:

e See 15 Connecting to Your System Over the Internet on PC or Mac, page 78.
OR

e See 17 Connecting to your System Using Smartphone or Tablet Apps, page 109.

Connectivity using Lorex’s free DDNS service is also available, but requires the ports listed
above to be port forwarded on your router.
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Basic Setup (LNR400 Series)

6.10 Quick Access to System Information
To quickly open a window that displays vital system information:

* Right-click to open the Quick Menu and click Info. Enter the system user name (default:
admin) and password (default: 000000).

vice ID

b95al6
1up is not available
G

E nore

The QR code shown in the System Info screen can be scanned during mobile setup to enter the system’s
Device ID.
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Basic Setup (LNR400 Series)

6.11 Connecting Cameras to the Local Area Network (LAN)

For flexibility, you may also connect IP cameras to the same Local Area Network (LAN) as
the NVR. This is accomplished by connecting the cameras to the same router as the NVR.

For these installations, an external PoE switch (sold separately) or power adapter (sold
separately) must be used to provide power to each IP camera. You also must add the cam-
eras on the NVR before they will show a picture on the monitor or be recorded by the NVR.

Follow the steps below to connect the cameras to the NVR over the LAN.

E note

e Compatible with Lorex 1080p wired POE HD cameras only. For a list of compatible cameras, please
visit www.lorextechnology.com/support.
e Camera and NVR images in this section are used for illustration only.

Step 1 of 2 — Option A: Connecting cameras to your local network using a PoE
switch:

é e g dv

Router NVR |P Cameras

POE SWiTChﬁ @f @f @f @f

IP Cameras

1. Connect an Ethernet cable from the LAN port on an external PoE switch (sold sepa-
rately on www.lorextechnology.com) to your router using a CAT5e or higher Ethernet
cable. Connect the power cable to the PoE swtich and to a power outlet or surge
protector.

@ NOTE

Terminology may vary depending on the model of PoE switch you have.

2. Connect the IP cameras to the PoE switch using the Ethernet extension cables. The
PoE switch will provide power and video transmission the same way as your NVR.
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Basic Setup (LNR400 Series)

Step 1 of 2 — Option B: Connecting cameras to your local network using power
adapters:

b —

Router NVR

A

IP Cameras
IP Cameras Power adapter (not included)

1. Connect each camera to a compatible power adapter (visit www.lorextechnology.com
for compatible power adapters for your cameras).
2. Connect the camera to your router using a CAT5e or higher Ethernet cable.

Step 2 of 2: Add the cameras to your NVR:

1. Right-click and select Device Search .

2. Log in using the admin account (default User Name: admin; default Password:
000000).

3. Click Device Search. The system searches the network for compatible cameras.

Remote Device

Port

35000

Device Search Display Filter None

Modify Delete Status Por Device Name

< (11}
Delete Manual Add

ﬂ

4. Check the camera(s) you would like to add.
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Basic Setup (LNR400 Series)

5. Click Add. The Status indicator turns green to show the camera is successfully
connected.

Remote Device

Port

Device Search Add Display Filter INone

Added Device

Port D
850.136 35000 FI
x 101167 Port3  PC3K300604275

[l
Delete Manual Add

6. Click OK to save changes.

@ NOTE

You can also add a camera to a specific channel by hovering the mouse over an empty channel in split-

+
screen view and clicking . Then double-click the camera you would like to add and right click to exit.
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Mouse Control

The mouse is the primary control device for the system. To connect a USB mouse:

e Connect a USB mouse to the USB port on the front or rear panel.

Q) — @ )

0

1. Left-button:

¢ In live view, click to open the Navigation Bar. Right-click to close the navigation bar.
* In live view, while in a split-screen display mode, double-click an individual channel

to view it in full-screen. Double-click again to return to the split-screen display mode.
¢ While navigating menus, click to open a menu option.

2. Right-button:

* During live view, right-click anywhere on the screen to open the Quick Menu.
¢ Within system menus, right-click to exit menus.

3. Scroll wheel: In live view, use the scroll wheel to zoom in/out.
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Using the System

Use the system’s graphical on-screen display to navigate menus and configure options
and settings.

8.1 On-Screen Display

The system shows the following for all display views:

03-26-2014 08:58:20PM

CAM7 C

1. Display area:

* Double-click on a channel to view in full-screen; double-click again to return to split
screen.

* Right-click to open the Quick Menu.

* Left-click to open the Navigation Bar.

¢ Move the mouse to the top of a channel to view the Camera Toolbar.

¢ Click-and-drag cameras to rearrange the channel display. This does not affect the
channels each camera is connected or recording to.

Channel name

C: Camera is continuously recording.

M: Motion has been detected.

Date & time: Current system date and time. For details on setting the date and time,
see 9 Setting The Time, page 23.

aorwn
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Using the System

8.2 Using the Quick Menu

The Quick menu gives you access to the system’s key functions. To access the Quick
Menu, right-click the screen during live view.

View 1
View 4
View 8
View 9
PIZ
AutoFocus

Color Setting
Info
1 Seguence

O, Search

¢ Manual Control »

¢ Device Search
Main Menu

The Quick Menu has the following options:

¢ View: Select a camera in full-screen or select a multi-channel display.

¢ Pan/Tilt/Zoom: Access controls for PTZ cameras (not included).

¢ AutoFocus: Access zoom/focus controls for auto-focus cameras (not included).
* Color Setting: Configure image settings for cameras.

* Info: Opens the system information window.

¢ Sequence: Click to start/stop sequence mode.
In sequence mode, the system will automatically cycle through connected cameras

every few seconds. A (J will appear to show that sequence mode is on.

Click the icon to pause sequence mode on the channel that is currently shown (icon
changes to ). Click again to resume sequence mode.

Right-click and select Sequence to return to normal viewing mode.

e Search: Search/playback recorded video. See 11 Search (Playback), page 26.

* Manual Control: Click Record to open the Record menu to select manual recording
options. See 10.3 Setting up Scheduled or Manual Recording, page 24. Click Alarm
Output to control alarm ouput devices (not included).

* Main Menu: Open the Main Menu. See 14 Using the Main Menu, page 42.

8.3 Adjusting Camera Image Settings
Use the Camera menu to adjust image settings for your cameras.
To adjust image settings:

1. Right-click on the channel you would like to configure and select Color Setting. Enter
the system password if prompted.
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Using the System

2. Configure the following settings as needed:

Camera

Enable ® Disable

No Flip
® Enable Disable

Off

e |Schedule

DayLight Schedule

= —

@ NOTE

The settings listed below are only shown if they are supported on the selected camera. Some camera
models do not support all settings.

e Mirror: Select Enable to flip the image horizontally.

* Flip: Select Flip 180° to flip the image vertically, or select No Flip for the default
orientation.

¢ 3D Denoise: Select Enable to turn on the camera’s noise reduction feature. Noise
reduction will ensure a cleaner image, especially at night, and may reduce the
amount of disk space required to store video.

¢ BLC Mode: Select High or Low to enable back light compensation or Off to dis-
able. Back light compensation adjusts the lighting levels in the picture so you can
see objects in the foreground if there is a strong light source behind them.

¢ Scene Mode: The Scene Mode allows you to adjust white balance levels for the
camera. Select Schedule for the camera to automatically adjust the white balance.
Select Sunny or Night to use preset white balance levels. Select Customized to
manually set blue and red levels.

* DayLight: This setting sets the camera’s day/night mode. Select Colorful for the
camera to use color mode at all times. Select Schedule for the camera to automati-
cally determine whether to use color or black and white mode. Select Black&White
for the camera to use black and white mode at all times.

E nore

It is recommended to select Schedule mode, as using Colorful may impact the camera’s perform-
ance at night.

* Saturation: Adjust the vibrancy of colors in the image.
* Hue: Adjust the color hue of the image.

¢ Brightness: Adjust the image brightness.

* Contrast: Adjust the image contrast.

3. Click OK to save changes.

@ NOTE

You must save changes to apply settings changes. It is recommended to adjust one setting at a time
s0 you can see the results of each change. Click Default to reset the camera to default image
settings.
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Using the System

8.4 Using the Navigation Bar

The Navigation Bar gives quick access to certain functions and menus.

To open the Navigation bar:

Left click on the screen to open the Navigation Bar. The Navigation Bar has the follow-
ing options:

©CONOOAWND

14.

Main Menu.

Collapse.

Select display layout.

Sequence: Click to start/stop sequence mode.

PTZ: Click to open PTZ controls.

Camera: Click to open camera image settings.

Search: Search and playback recorded video. See 16.4 Playback, page 90.
Alarm Status: View alarms in progress. See 14.2.4 Event Info, page 49.
Channel Info: Click to access status information about connected cameras.

. Device Search: Manage IP cameras over the network.
. Network: Configure network settings for your system. See 14.3.1 Network, page 53.
. HDD Manager: Manage hard drives connected to the system. See 14.3.19 Format-

ting the Hard Drive, page 67.

.USB Manager: Click to access options for connected USB thumb drives (not in-

cluded). You can backup video, logs, or system configurations and install firmware
upgrades.

System Upgrade: Check for firmware upgrades. The system must be connected to
the Internet to check for or receive updates.

8.5 Using the Camera Toolbar

The Camera Toolbar is used to perform actions on a specific channel.

To access the Camera Toolbar:

Move the mouse to the top of the channel display. The Camera Toolbar has the follow-
ing options:

akrwh =

Quick Playback.
Digital Zoom.
Real-time backup.
Snapshot.

Not supported.

8.5.1 Using Quick Playback

Quick Playback is used to playback the last 5~60 minutes of video from the selected chan-
nel. You can also access Quick Playback in split-screen mode, while still viewing live video
from the other channels.
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Using the System

To use Quick Playback:

1.

Move your mouse to the top of the channel display and click B

@ NOTE

By default, the system will begin playback from 5 minutes ago. You can increase this to up to 60 mi-
nutes using the Realtime Play setting in Main Menu>Setting>General.

2. Right-click to exit Quick Playback.

8.5.2 Using Digital Zoom in Live Display

1.

Move your mouse to the top of the channel display and click Q to activate digital
zoom. A check mark will appear in the icon to indicate digital zoom is activated.

@ NOTE

You may activate digital zoom in multiple channels at the same time.

Click and drag inside the channel to zoom in.

¢ Click and drag to pan the zoom area.
¢ Right-click to zoom out and select a new zoom area.

* Click Q to disable digital zoom. Note that the channel will remain at the same
zoom level until you right-click inside it.

8.5.3 Using Real-time Backup

Real-time backup allows you to save footage from the live display to a USB thumb drive
(not included) or external hard drive (not included).

To use Real-time Backup:

1.

Insert the USB thumb drive or external hard drive into one of the USB ports on the
system.

Move your mouse to the top of the channel display and click ﬁ to start Real-time
Backup.

Click ﬁ again to end Real-time Backup. The file is saved to your USB device.

@ NOTE

If the system prompts you to log in, you will need to click ﬁ again to start Real-time Backup after
logging in.

8.6 Using the Virtual Keyboard

The Virtual Keyboard is used to input text or numeric values in certain menus.
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Using the System

1. Backspace.

2. Enter capital letters.

3. Confirm entry.

8.7 Adjusting Camera Zoom & Focus

Auto-focus cameras (not included) have a motorized lens. The motorized lens allows you
to control the zoom and focus settings using the menus on your system.

AutoPtz

Zoom WIDE 8
Focus ]

AutoFocus Reset

Refresh

To adjust the camera’s zoom focus:

1. Double-click on the channel where the motorized lens camera is connected.

2. Right-click and then click AutoFocus. Log into the system using the admin account
(default user name is admin and password is 000000).

3. Adjust the zoom and focus using the following options:

¢ Use the sliders to adjust the Zoom WIDE or Focus settings for the camera.

E note

Hover the mouse over the sliders and use the mouse wheel to adjust by 1% at a time.

* Click the AutoFocus button to automatically focus the camera at the current zoom
level.

* Click Reset to return the camera to the default zoom and focus levels.

* Click Refresh to refresh the settings shown on the system if someone has used the
manual lens controls on the camera.

4. Right-click to exit and save changes.
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Setting The Time

/\  cauTion

It is highly recommended to set the date and time when first setting up your system.

Inaccurate time stamps may render your footage unusable for court evidence.

To set the date and time:

1.
2.

3.

&

In the main viewing mode, right-click and click Main Menu.
Log in using the system user name (default: admin) and password (default: 000000).

Click “ and select Setting. Click General and select the Date&Time tab.

GENERAL
DISPLAY.
RS232 MM DD YYYY mat 12-HOUR

General e | Holiday

PANITILTIZOOM
ACCOUNT 30- 20 D! GMT-05:00 ~
Conlig Backup

DEFAULT

UPGRADE

poolnip.org Manual Update
123

Interval 2 Minute

Default C Cancel

Under System Time, enter the current time and select your time zone. Then, click OK.
Check the DST check box to enable auto Daylight Savings Time updates.

@ NOTE

¢ You can adjust the Start Time and End Time for Daylights Savings Time if the default settings do
not match your region.

* Under DST Type, select Day of Week to set the start and end time based on a day and week (e.g.
2nd Sunday in March), or select Date to set the start and end time to a specific date.

(Optional) Check the NTP check box to sync your system with an Internet time server.
Click Manual Update to instantly update the time.

@ NOTE

* Your system must have a constant connection to the Internet to use NTP.
* (Advanced) You can enter a custom NTP server under Server IP and Port, and you can select

how often the system will sync the time using Interval.

Click Apply to save changes.
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Recording

By default, the system is set to immediately record video from connected cameras contin-
uously, 24 hours a day. You can customize the recording settings according to your needs.
10.1 Video Recording Types

The system supports the following recording types.

* Recording—Continuous: Normal, continuous recording. A . icon is shown when
recording is in progress.

* Recording—Motion: The system records when motion is detected by the camera. An

. icon is shown when motion is detected.

10.2 Main Stream and Sub Stream

The system employs two video recording streams, a Main Stream and a Sub Stream. Both
Main Stream and Sub Stream recording are enabled by default.

The Main Stream records high quality video to your system’s hard drive.

The Sub Stream records lower resolution video for efficient streaming to devices over the
Internet. Sub Stream recording must be enabled to view video recordings on a computer
or mobile device.

You can configure the video quality parameters for the Main Stream or Sub Stream. For
details, see 14.1.6 Configuring Recording Quality, page 44.
10.3 Setting up Scheduled or Manual Recording

You can set the system to record based on a schedule or you can manually turn recording
on and off. By default, the system is set to record on an always on recording schedule.

To configure the recording schedule, see 14.3.15 Configuring the Video Recording Sched-
ule, page 64.

To select between scheduled and manual recording:

1. Right-click and then select Manual>Record.

SCHEDULE
HDD MANAGER
RECORD
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Recording

4.

5.

Under Main Stream, select how the system will record the Main Stream for each
channel.

¢ Schedule: Main Stream Recording will follow the recording schedule.

e Manual: The system will record the Main Stream continuously as long as this option
is checked.

¢ Stop: The system will not record the Main Stream for this channel. This option is
not recommended.

Under Sub Stream, select how the system will record the Sub Stream for each
channel.

* Schedule: Sub Stream Recording will follow the recording schedule.

¢ Manual: The system will record the Sub Stream continuously as long as this option
is checked.

e Stop: The system will not record the Sub Stream for this channel.

Under Snapshot, select Enable to enable snapshot recording on each channel. Or,
select Disable to disable snapshot recording.
Click OK to save changes.

10.4 Configuring Hard Drive Overwrite

When the hard drive is full, the system will overwrite the oldest recordings by default. This
is recommended, as it makes sure that your system will continue to record without any in-
put from you. You can also set the system to stop recording once the hard drive is full.

To configure hard drive overwrite:

1.
2.

3.

Right-click and select Main Menu. Click “> Setting>General>General.

Under HDD Full, select Overwrite for the system to overwrite the oldest recordings
when the hard drive is full. Or, select Stop Record for the system to stop recording
when the hard drive is full.

GENERAL
DISPLAY

RS232
PANTILTIZOOM
ACCOUNT
Conig Backup
DEFAULT

Default

Click OK to save changes.
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Search (Playback)

Search mode is used to navigate and playback recorded video files on the system.

11.1 Playing Back Video from the Hard Drive

1. From live view, right-click and then click Search.
2. Log in using the system user name (default: admin) and password (default: 000000).

3. Configure the following:

From ReadWrite Hdd|~
® REC PIC

Q(Mar 5)(2014) &
Su Mo TuWe Th Fr Sa

3.1. Use the calendar on the right to select the day to playback.

3.2.  Use the drop-down menus to select the channels you would like to playback.

@ NOTE

Click the display options (m) to playback multiple channels simultaneously.

3.3. Click inside the video bar to select the playback time. The system will begin
playing back at the selected time.
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Search (Playback)

11.2 Playback Controls

From ReadWrite Hdd|~
® REC PIC

Select playback device.

Calendar: Select the day to playback.

Channel select: Select channels to playback.

Video clip backup: Select video clip start and end times.
Backup video clip: Click to save selected clip.
Playback Bar: Click inside the bar to select a playback time.
Zoom Playback Bar: Select scope of time bar.
Recording types: Click to show/hide recording types.

. Speed up

10. Slow

11. Previous/next frame

12. Play backward

13. Stop

14. Play

NGO RN~

©

11.3 Playing Back from a USB Drive

If you have video files saved to a USB thumb drive (not included) or external hard drive
(not included), you can play them back using the system.

To play back from a USB drive:

1. Connect the USB thumb drive (not included) or USB external hard drive (not included)
with video files on it into a USB port on the system.

2. From live view, right-click and click Search.

3. Log in using the system user name (default: admin) and password (default: 000000).
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11 Search (Playback)

4. Click From ReadWrite Hdd and select From 10 Device. Click Browse to open the
USB drive and manually select the video file.

Narne.
LHV1008_chi_main 201

5. Double click the video file you would like to open.

11.4 Using Smart Search

Smart Search makes it easy to review motion events in specific zones of your video
stream. Select the areas that interest you and Smart Search plays your recording from the
time when your camera detects motion in those areas. To set up smart search:

1. In the multiple-channel playback mode, double-click a channel and then click the

R

Smart Search icon (=% ).
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2. To create a Smart Search zone, left-click and select the area that you want to detect
motion.

f

3. Repeat these steps for each channel that you want to use Smart Search.

4. Click Q to start the Smart Search playback. To stop the Smart Search playback,

click g.' again.
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Backup

Backup video files to external USB thumb drive (not included) or self-powered USB exter-
nal hard drive (not included).

E norme

USB external hard drives (not included) must be formatted in the FAT32 file format to be used with the
system.

12.1 Formatting the USB Thumb Drive

It is recommended to format your USB thumb drive (not included) before using it with the
system.

/\  cauTion

Formatting the USB device will permanently erase all data.

To format a USB device:

1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then select Main Menu. Login if prompted.

3. Click E>Backup.

4. Select the USB device you would like to format under Device Name and click Browse.

BACKUP

Device Name | sdb1(USB DISK) ~ Browse
(Space Needed) 6.05 GB/7.23 GB(Free/Total)

04-25- 2014 12:00: 00 AM
04-25- 2014 11:25: 48 AM 2\ Remove

el Type  StartTime

Backup

5. Click Format. Click Yes to confirm.

Browse

Device Name | sdb1(USB DISK) . Free/Total) Refresh Format
/new folder/ New Folder

Name

=
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12.2 Backing up Video

—_

Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then select Main Menu. Login if prompted.

3. Click E>Backup.

4. Configure your search options:

BACKUP

Browse

6.05 GB/7.23 GB(Free/Total)

2:00: 00 AM
25: 48 AM - Remove
Start Time s

Backup

* Select the USB device you would like to back up to under Device Name.

* Type: Select the recording type you would like to search for or select All to search
all recording types.

¢ Record CH: Select the channel you would like to search or select All to search all
channels.

* File Format: Select DAV to save files to save files to .dav format. You can use the
Video Player from www.lorextechnology.com/support to playback .dav files on PC
or Mac. Or, select ASF for .asf format. You can playback .asf files in VLC Media
Player (free download from www.videolan.org) on PC or Mac.

@ NOTE

VLC Media Player is a free software available from www.videolan.org. VLC Media Player is not
supported by Lorex.

* Start Time/End Time: Select the start and end time for your search.

5. Click Add. A list of files that match your search criteria appears.
6. Check files you would like to backup and then click Start. Wait for the backup to
complete.

E note

HD video files saved on the system may take up a large amount of disk space. The size of video files
selected and the amount of free space on your USB device is shown at the top of the screen.

12.3 Using Video Clip Backup

Video clip backup allows you to select a duration of video during playback mode and save
it to a USB device (not included).

To use Video Clip Backup:

1. Insert a USB thumb drive (not included) or USB external hard drive (not included) into
one of the USB ports.
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2. Start playing back video using the steps in 11.1 Playing Back Video from the Hard
Drive, page 26.

3. Click to mark the beginning of the video clip. Click again to mark the end of

the video clip.

4. Click to open the Backup menu.

5. Configure the following:

5.1. Check the USB device where you would like to save the file.

5.2.  Check the files you would like to backup.

5.3. Click Backup. Then click Start. Wait for the backup to complete before remov-
ing the USB thumb drive.

12.4 Viewing Backup Files

To playback .dav backup video files, a Player is available for PC and Mac at
www.lorextechnology.com/support. The PC version of the player is automatically saved to
your USB device (not included) when you create a backup file.

12.4.1 Viewing Backup Files on PC

You can download Video Player for PC from www.lorextechnology.com/support.

To view backup video files using the Player on PC:

1. Download and install the Video Player for PC from www.lorextechnology.com/support.
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2. Click & to open a back up video file.

? -8 x

Smart Player [
Group Fie List 0 | fJprey vanaow

OCoIN000 .

e e e e e 5o T e § s e £t {2 £ 3 5 s 6 e e e 19 20 e 2 e 22 e 232

3. Use the Player controls to control playback or select other files for playback.

Video Player Controls

AN

O e o000 = =

CTOYG G SO - NG VO N S M O M (N W S W}

1. File List: Double-click to open a file.
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2. Display Area: Select the split-screen mode. Double-click a video file to expand. Click
the controls inside the display area to do the following:

. : View information about the video file.
o n: Start/stop a manual recording from the video file.
o E: Take a snapshot from the video file.

. : Close the video file.
3. Hide/show file list.

4. Playback controls:

: fa-l: Playback files in sequence.

. F:-.: Synchronize playback times.

[ Play/pause playback.

. o Stop playback.

. -.‘I. : Previous frame.

r
. '.I’-:Nextframe.

1X

: Playback speed.

. "-:'_:-I =" \olume control.

5. Zoom Timeline.

6. Add Files: Click to open back up video files.

7. Digital Zoom: Click to activate digital zoom mode. Click and drag in the video to zoom
in. Right-click to unzoom.

8. Drag: When digital zoom is activated, click to activate drag mode. Then click and drag
in the video to view different areas of the image.

9. Full-screen: Click to open the player in full screen. Press ESC to exit full screen.
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10. Config: Click to open the configuration menu for the player. From here you can control
the default file formats and save locations for snapshots and video files saved from the

player.

12.4.2 Viewing Backup Files on Mac
AVideo Player for Mac is available from www.lorextechnology.com/support.

To view backup video files using the Player on Mac:

1. Download Video Player for Mac from www.lorextechnology.com/support.
2. Double click the downloaded file in Safari to extract the Smart Player app file.
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4. Click ﬂ to open a back up video file in another location.

014 06/10:43 AM

5. Use the Player controls to control playback or select other files for playback.

Video Player Controls

BEESEE2 0L 0G0 5 AV

1. File List: Double-click to open a file.

2. Display Area: Select the split-screen mode. Double-click a video file to expand. Click
the controls inside the display area to do the following:

. .: View information about the video file.
. .: Take a snapshot from the video file.

. -: Close the video file.
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3. Hide/show file list.

4. Playback controls:

r
. h@]: When a video file ends, this button lets you select if you want the video player
to repeat the same file or play the next file.

'/_\
. hzl Play/pause playback.
m
e [ Stop playback.
)|
o 4 Previous file.
r
o (2 Next fie.
o —: Playback speed.
o : Volume control.

Zoom Timeline.

Add Files: Click to open back up video files.

Full-screen: Click to open the player in full screen. Press ESC to exit full screen.
Config: Click to open the configuration menu for the player. From here you can control
the default file formats and save locations for snapshots and control the aspect ratio.

© N O

9. About: Click to see version information for the Player software.
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Managing Passwords and User
Accounts

By default, the system user name is admin and the password is 000000. Passwords are
enabled by default and are required to access the Main Menu or connect to the system us-
ing a computer or mobile device. You will be prompted to create a custom password after
you connect for the first time.

@ NOTE

If you forget the password to the system, contact technical support to have it reset.

The system includes the following default accounts:

e admin: The admin account has full access to the system, may configure all system set-
tings, and can manage user accounts.

» default: The default account is a limited user account that may only view live video from
the cameras.

For security reasons, it is essential that you change the password on your system. By de-
fault, the system password is enabled.
13.1 Changing Passwords

You can change the system password of the admin and user accounts from the Users
menu.

To modify an account password:

1. From Live View, right-click and then select Main Menu.
2. If prompted, enter the system user name (default: admin) and password (default:
000000).

3. Click “ and select Setting. Select Account.

4. Click next to the user account you would like to modify.

GENERAL

UPGRADE

5. Check Modify Password.

6. Under Old Password, enter the account’s previous password.

7. Under New Password, enter a new 6 character password for the account. Repeat the
new password under Confirm Password.

8. Click OK to save changes.
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13.2 Adding Users

You can allow multiple users to log in to the system. When adding different users, you can
assign what menus they have access to. For example, you may want your friend to monitor
your system while you are away, while not giving full access to your system.

To add a user account:

1.
2.

From Live View, right-click and then select Main Menu.
If prompted, enter the system user name (default: admin) and password (default:
000000).

Click “ and select Setting. Select Account.

Click Add User.
Configure the following:

User Name: Enter a name for the user account.

Password: Enter a 6 character password for the user account. Enter the password
again under Confirm Password.

Memo (optional): Enter a description of the user account.

Group: Select the group you would like to assign to this user account. A user ac-
count cannot be given permissions its group does not have.

Multiuser: Check to enable this user account to be used to login from more than
one device at the same time.

Authority: Check the permissions you would like the user account to have. Under
the System tab, select the menus the user account may access. Under the Play-
back tab, select which channels the user account may access recorded video from.
Under the Covert tab, select the channels the user account may view live video
from.

6. Click OK to save changes.

Now, you can log in to the system locally, or remotely using the user name and password
you created. When logging into the system with a user account, the user will only have ac-
cess to the menus you assigned.

13.3 Modifying Users

1. Inthe Account menu, click next to the user account you would like to modify.

2. Update the user’s account details as needed, and then click OK to save changes.
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13.4 Deleting Users

1.

In the Account menu, click next to the user account you would like to delete.

2. Click OK to confirm.

@ NOTE

The admin and default user accounts cannot be deleted from the system.

13.5 Account Groups

Account groups can be used to easily manage permissions for multiple user accounts.
User accounts can be given all the permissions of a group, but cannot be given permis-
sions that the group does not have.

The system includes the following groups by default:

admin: Accounts in the admin group are system administrators. They have full access
to the system, may configure all system settings, and can manage user accounts.
user: Accounts in the user group are normal users. They have limited access to system
menus.

13.6 Adding Groups

From Live View, right-click and then select Main Menu.
If prompted, enter the system user name (default: admin) and password (default:
000000).

Click “ and select Setting.

Click Account and select the Group tab.
Click Add Group.

GENERAL

Config Backup

DEFAULT
UPGRADE
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6. Configure the following:

EVENT

&
(]

SHUTDOWN

M

¢ Under Group Name, enter a name for the group.

¢ Under Memo, enter an optional comment for this group.

e Under Authority, check the permissions that the group will have. User accounts as-
signed to this group can not be given any permissions the group does not have.

7. Click OK to save changes.

13.7 Modifying Groups

1. Inthe Group tab, click next to the group you would like to modify.

2. Update the group’s details as needed, and then click OK to save changes.
13.8 Deleting Groups

1. Inthe Account menu, click next to the user account you would like to delete.
2. Click OK to confirm.

E nore

The admin and user groups cannot be deleted from the system.

#L.X400021; r.29578/29578; en-US 41



14

Using the Main Menu

To open the Main Menu:

¢ Using the Mouse: Right-click and click Main Menu.

|§| NOTE

The system password may be required to access the Main Menu. By default the user name is admin
and the password is 000000.

RO S G

MAIN MENU

1. SEARCH: Open Search/Playback mode. For details, see 11 Search (Playback), page
26.

BACKUP: Export files to USB device. For details, see 12 Backup, page 30.
CAMERA: Open the menu to manage IP cameras connected to the network (see 6.11
Connecting Cameras to the Local Area Network (LAN) for details), set recording pa-
rameters, and assign custom titles for your cameras.

INFO: View system information.

SETTING: Configure general system, schedule, network, recording, display, and mo-
tion settings. Restore system to factory defaults.

6. SHUTDOWN: Logout, restart, or shutdown the system.

SEN

ok

14.1 Camera

Open the Remote Device menu to manage IP cameras, set recording parameters, and as-
sign custom titles for your cameras.

— CAMERA
REMOTE DEVICE
RECORDING
CHANNEL NAME

TR B PO —

MAIN MENU

14.1.1 Remote Device

The Remote Device menus allow you to add cameras over the local area network (LAN),
configure camera image settings, view camera status, and upgrade camera firmware.

e See 6.11 Connecting Cameras to the Local Area Network (LAN) for instructions on con-
necting cameras to the NVR over the network.

* See 8.3 Adjusting Camera Image Settings, page 18 for details on setting up camera im-
age settings.
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14.1.2 Viewing Camera Status
The Camera Status menu allows you to view the connection and alarm status for all con-
nected cameras.

To view camera status:
I ————————

1. From the Main Menu, click w5 and select Remote Device>Status.

Remote Device
CAMERA
STATUS
FIRMWARE
UPGRADE

Refresh

REMOTE DEVICE|

14.1.3 Viewing Camera Firmware Versions

You can use the Firmware menu to view firmware versions for connected cameras.

To view camera firmware versions:
———————

1. From the Main Menu, click _ and select Remote Device>Firmware.

[
Type

S v IPC-HFWAZ00SK

STATUS 2 2. 2 DNB16M2

FIRMWARE

UPGRADE

Refresh

14.1.4 Upgrading Camera Firmware

You can update the firmware for connected IP cameras through the NVR. Firmware up-
grades provide enhanced functionality for the cameras. Lorex provides firmware upgrades
for free from www.lorextechnology.com/support.

To upgrade the camera firmware:

1. Download the camera firmware from www.lorextechnology.com/support if one is
available.

@ NOTE

Make sure that the firmware file you are using is compatible with your IP camera model.

2. Extract the firmware file and copy it to a USB thumb drive (not included).
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3. Insert the USB thumb drive (not included) into a USB port on the system.

4. Right-click and select Main Menu. Click and select Remote

Device>Upgrade.

Remote Device
CAMERA
STATUS
FIRMWARE
UPGRADE

2

Start Upgrade

5. Click Select. Select the firmware file on the USB drive and click OK.
6. Check the cameras you would like to apply the upgrade to in the list and then click
Start Upgrade.

/\  cauTion

Wait for the firmware upgrade to complete before turning off or unplugging the cameras or NVR. The
cameras will restart during the firmware update process.

14.1.5 Recording

The Recording menu allows you to set recording parameters for your cameras, such as
the resolution and frame rate.

14.1.6 Configuring Recording Quality

The system employs two video recording streams, a Main Stream and a Sub Stream. The
Main Stream records high quality video to your system’s hard drive. The Sub Stream re-
cords lower resolution video for efficient streaming to devices over the Internet. You can
customize the video quality settings for these streams according to your needs.

To configure recording quality:

1. From the Main Menu, click and select Recording>Recording.

2. Under Channel, select the camera you would like to configure.
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3. Configure the following settings. Settings for the Main Stream are in the left column.
Settings for the Sub Stream are in the right column.

RECORDING
SNAPSHOT

Sub Stream1 ~
H.264
352:240(CIF) ~

10
VBR
4

ed ~| (4000 |80

¢ Resolution: Select the resolution that you want to use to record the selected chan-
nel. Higher resolutions create a more detailed image, but take up more hard drive
space to record and require more bandwidth to stream to connected computers or
mobile devices.

@ NOTE

Available resolutions for the Main Stream and Sub Stream depend on the model of camera that is
connected to the system.

* Compression: Select the video compression type that will be used. It is recom-
mended to select H.264, as it will have the best performance and use the least
amount of disk space.

* Frame Rate (FPS): Select the frame rate in Frames Per Second (FPS) that each
stream will record at. A higher frame rate provides a smoother picture, but requires
more storage and bandwidth.

* Bit Rate Type: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate) to deter-
mine the bit rate type. If you select VBR, you can set the video quality setting be-
tween 1 and 6. If you select VBR, select the Quality from 1 (lowest) to 6 (highest).

* Bit Rate (Kbps): Select the bit rate for each recording stream. A higher bit rate re-
sults in a better image, but increases the amount of hard drive space or bandwidth
required.

@ NOTE

The Audio/Video setting is not supported.

4. (Optional) Click the Copy button to copy recording settings to other channels.
5. Click OK to save changes.

14.1.7 Configuring Snapshot Recording Settings

The system can be set to record snapshot images when a camera detects motion. These
snapshots can be viewed through the Search menu or can be attached to email alerts and
push notifications. The Snapshot tab in the Recording menu controls the quality and re-
cording parameters for each camera.
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@ NOTE

In order to enable Snapshot recording, the following menu options must be configured:

¢ The Snapshot schedule must be enabled for times that you would like to save snapshots. See 14.3.17
Configuring the Snapshot Schedule, page 66.
* Snapshot recording must be enabled for motion detection in the Event menu. See 14.3.8 Configuring

Motion Detection, page 58.

To configure snapshot recording settings:

1. From the Main Menu, click and select Recording>Snapshot.

2. Under Snap Number, select the number of snapshots the system will take when the
snapshot button is pressed.

3. Configure the following settings for snapshots saved automatically from motion detec-
tion or the snapshot schedule:

RECORDING

Recording

e Channel: Select the channel you would like to configure.

* Mode: Select Timing for the system to take snapshots according to the snapshot
schedule (see 14.3.17 Configuring the Snapshot Schedule, page 66) Select Trig-
ger for the system to take snapshots only when triggered by motion detection
(snapshot must be enabled in the Motion Detect menu; see 14.3.8 Configuring Mo-
tion Detection, page 58).

¢ Image Size: The image size is the same as the Main Stream resolution of the
camera.

* Image Quality: Select the snapshot image quality between 1 (lowest) and 6
(highest)

* Snapshot Frequency: Select the number of snapshots (up to 6) the system will
take each time.

4. Click OK to save changes.

14.1.8 Creating Custom Channel Names

You can assign custom names to your cameras. For example, you can name your cameras
based on their location (e.g. hallway or front door).

To create custom channel names:
I ————————

1. From the Main Menu, click and select Channel Name.
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2. Enter a custom name for each channel.

Detfault OK Cancel

3. Click OK to save changes.
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14.2 Info

Info contains menus that show you system information.

INFO
INFO
EVENT
NETWORK
BPS

LOG

MAIN MENU

14.2.1 HDD Info

HDD INFO
RECORD INFO
VERSION

Total Space
0.00 MB

The HDD Info sub-menu shows information related to the hard drives installed in the sys-
tem, including capacity, status, and type.

To access the HDD Info menu:
¢ From the Main Menu, clickE and then click Info>HDD Info.

14.2.2 Record Info

HDD INFO
RECORD INFO
VERSION
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The Record Info menu shows the start and end times of recordings saved on the hard
drive.

To access the Record Info menu:
¢ From the Main Menu, clickE and then select Info>Record Info.

14.2.3 \Version

HDD INFO
RECORD INFO
VERSION

YPA3JQ059D00006

The Version sub-menu allows you to view information about the current firmware installed
on the system.

To access the Version menu:
¢ From the Main Menu, clickE and then click Info>Version.

14.2.4 Event Info

The Event Info menu shows you a display of system alarms. Activated alarms are high-
lighted in white. Additional info such as channels that are currently detecting motion is
shown.

The following alarms are shown in the Alarm Status menu:

* No HDD: No hard drive is detected.

* Disk Error: Hard drive error detected.

e Disk Full: Hard drive is full.

¢ |P Conflict: More than one device on the network is using the same IP address.

* Net Conflict: System is not connected to the network.

¢ MAC Conflict: More than one device on the network is using the same MAC address.
* External Alarm: Sensor/alarm device (not included) has been triggered.

* Video Loss: Shows disconnected channels.
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e Camera Masking: Camera masking alarm has been triggered (e.g. someone has cov-
ered the camera lens).

¢ Motion Detect: Shows channels with active motion alarms.

* IPC Ext Alarm: Alarm/sensor device (not included) connected to camera has been
triggered.

¢ |PC Offline Alarm: IP camera is offline.

To access the Event Info menu:
¢ From the Main Menu, clickE and then select Event.

14.2.5 Online Users

ONLINE USERS
LOAD.
TEST

The Online Users menu shows a list of users connected to the system using computers or
mobile devices.

To access Online Users:
¢ From the Main Menu, cIickE and then select Network.

14.2.6 Load

ONLINE USERS

LOAD Name _MAC Staus P Address Type  MTU
== LANT  90:0: Succeed 10.18. 7 Ethemet 1500

The Load menu shows you the network traffic your system is sending and receiving.

To access Load:

¢ From the Main Menu, clickE and then select Network>Load.
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14.2.7 Test

ONLINE USERS
LOAD
TEST

e (sdal(USB DISK) = ( Refresh

10.18.117.107

The Test menu allows you to test if your system can connect to other devices over the LAN
or Internet. You can enter the IP address of a device and click Test to determine if your
system can connect to it.

To access Test:
¢ From the Main Menu, click E and then select Network>Test.

14.2.8 BPS

The BPS sub-menu shows the bitrates of connected cameras. the bitrate is the amount of
data the camera is sending to the system.

To access BPS:

¢ From the Main Menu, clickE and then select BPS.

14.2.9 Log

The Log sub-menu allows you to search for system logs.
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Search

4 Shut down at [04-24-14 06:49:57PM]
50:54 Reboot with Flag [0x01]
50:54 Disk totals<0>, Current working disk<->

RECORDING Config!
RECORDING Config!
ave RECORDING Conlig!

Backup Clear

Jumpto (1 (GO

To search for system logs:

1. From the Main Menu, click E and then select Log.

Under Type, select the log type to search for.

Under Start Time and End Time, select the start and end time for your search.

Click Search.

(Optional) Click Backup to export logs to a USB thumb drive connected to the system.

akrwb
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14.3 Setting

The Setting menu allows you to configure general system, schedule, network, recording,
display, and motion settings. It also allows you to restore the system to factory defaults.

NETWORK
EVENT
STORAGE
SETTING

MAIN MENU

14.3.1 Network

The Network menu allows you to configure network parameters for your system.

E note

The WiFi menu is not supported.

14.3.2 Selecting DHCP or Static IP Address (TCP/IP)
The TCP/IP menu allows you to configure IP address settings.

To configure IP address settings:

1. From the Main Menu, click “ and then select Network>TCP/IP.
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2.

3.

Check DHCP (recommended) to let the system automatically obtain an IP address
from the router or uncheck to assign a static IP address.

TCPIP
CONNECTION
WIFI

DDNS
IPFILTER
EMAIL

FTP

UPnP.

MTU

@ DHeP

Switch Settings

If you uncheck DHCP, configure the following:

* |P Address: Enter the IP address you would like to assign to the system. Make sure
that no other device on your network is using the same IP address.

* Subnet Mask: Enter the subnet mask for your network.

* Default Gateway: Enter the gateway address for your network.

¢ Preferred DNS: Enter the address of your primary DNS server.

¢ Alternate DNS: Enter the address of your secondary DNS server.

Click OK to save changes.

14.3.3 Configuring System Ports (Connection)

The Connection menu allows you to configure ports used by the system. Please note that
port forwarding is not required to use FLIR Cloud™ or to connect using the apps.

If you are using DDNS connectivity, port forwarding is required for the HTTP Port (defaut:
80) and TCP (Client Port) (default: 35000).

To configure system ports:

1.

From the Main Menu, click “ and then select Network>Connection.

TCPIP
CONNERTION
WIFI

DDNS

IP FILTER
EMAL

FTP.

UPnP

Configure the ports as needed and click OK to save changes.

@ NOTE

Up to 3 devices may connect to the system at the same time.
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14.3.4 Configuring DDNS Settings

Lorex DDNS is available as an optional connectivity option. Please see 18 DDNS Setup
(Advanced), page 147 for details.

The primary connectivity option uses FLIR Cloud™ to connect to your system over the In-
ternet without requiring port forwarding or DDNS registration. For details, see 15 Connect-
ing to Your System Over the Internet on PC or Mac, page 78.

To configure DDNS Settings:

1. Visit http://www.lorexddns.net and register for a DDNS account.

2. From the Main Menu, cIick“ and then select Network>DDNS.

TCPIP
CONNECTION

WIFI DNS Lorex DDNS
DDNSK

IP FILTER

Default Status

3. Check Enable.

4. Under Domain Name, enter the Domain Name/URL Request your received in the
email after registering for DDNS.

Under User Name, enter your DDNS User Name.

Under Password, enter your DDNS Device password.

7. Click OK to save your settings.

@ NOTE

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before at-
tempting to connect.

oo

14.3.5 Configuring Email Alerts

You can configure the system to send out email alerts for motion detection or other events.

E nore

To send out motion detection alerts, you must enable the Send Email option for motion detection on each
camera you would to receive alerts from. For details, see 14.3.8 Configuring Motion Detection, page 58.
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To configure Email Alerts:

1. From the Main Menu, click“ and then select Network>Email.

TCPIP.
CONNECTION
WIFI

DDNS

IP FILTER

Default Test ! Cancel Apply

NETWORK

2. Check Enable to enable email notifications.

If you want to use Lorex’s email server (recommended):

1. Check Lorex Mail to use the Lorex email server to send out alarm notifications. This is
the recommended setting.
2. Configure the following:

Receiver: Enter the email address that will receive alerts.

Sender: Enter the sender’s email address.

Subject: Enter the subject line for the email alert.

Attachment: Check to include a jpg image attachment of the camera.

@ NOTE

You must enable the Snapshot option for motion detection on each camera you would to receive
attachments. For details, see 14.3.8 Configuring Motion Detection, page 58.

Interval: Enter the interval between alert emails.

Health Enable: Check to enable health check emails. Health check emails will be
sent periodically to ensure that the system is functioning normally. If you enable
health check emails, enter the Interval in minutes below.

3. Click Test to send a test email.
4. Click OK to save settings.
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If you want to use your own email server (advanced):

1. Configure the following:

SMTP Server: Enter the SMTP server address.

Port: Enter the port used by the SMTP server.

Anonymous: Check if your server supports anonymous log ins. Otherwise, leave
this unchecked.

User Name: Enter the SMTP user name.

Password: Enter the SMTP password.

Receiver: Enter the email address that will receive alerts.

Sender: Enter the sender’s email address.

Subject: Enter the subject line for the email alert.

Attachment: Check to include a jpg image attachment of the camera.

|_§P| NOTE

You must enable the Snapshot option for motion detection on each camera you would to receive
attachments. For details, see 14.3.8 Configuring Motion Detection, page 58.

Encrypt Type: Select SSL or TLS if your server uses encryption. Select None if
your server does not use encryption.

Event Interval: Enter the interval between alert emails.

Health Enable: Check to enable health check emails. Health check emails will be
sent periodically to ensure that the system is functioning normally.

Interval: Enter the interval in minutes for health check emails.

2. Click Test to send a test email.
3. Click OK to save settings.

14.3

.6 Configuring Switch Settings (Advanced)

You can configure the networking settings for the internal PoE switch.

/\  cauTion

Itis

recommended to leave this menu on the default settings. Changing the information in this menu may

disrupt the connection to the cameras.

To configure switch settings:

1. From live view, right-click and select Main Menu.

2. Click “>Network>Switch Settings.

3. Configure the IP Address, Subnet Mask, and Gateway for the internal PoE switch.

TCPIP
CONNECTION
WIFI

DDNS
IPFILTER
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4. Click OK. Click Save to save changes. The system will restart.

14.3.7 Event

The Event menu allows you to configure settings for motion detection, video loss, and sys-
tem warnings.

14.3.8 Configuring Motion Detection

Motion Detection events allow the system to mark footage that has motion. This allows
you to quickly locate relevant footage through Search. You can also configure system re-
sponses to motion detection events, such as activating the system buzzer or sending an
email alert.

To configure Motion Detection events:

MOTION
WARNING R

1. From the Main Menu, click“ and then click Event>Motion>Motion Detect.

2. Under Channel, select the channel you would like to configure.
3. Check Enable to enable motion detection on the selected channel.
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4. Click Setup next to Region to configure which areas of the image will be enabled for
motion detection. A grid will appear over the camera’s live view.

Motion Grid

* Areas enabled for motion detection are shown in color and areas that are disabled
are transparent.

* Hover the mouse at the top of the screen to select which motion area you would like
to configure. You can set up to 4 motion detection areas and customize the sensitiv-
ity and threshold for motion detection separately for each area between 0 (lowest)
and 100 (highest).

* The Sensitivity determines how sensitive the camera is to motion. For example, if
the sensitivity is high, small amounts of motion are more likely to trigger an event. It
is recommended to select a Sensitivity between 30~70.

¢ The Threshold determines how much motion is required to trigger an event. If the
amount of motion exceeds the threshold, an event occurs. It is recommended to se-
lect a Threshold between 10~50.

* Right-click when finished.

@ NOTE

It is recommended to have a second person walk in front of the camera to test different Sensitivity
and Threshold settings to determine the best setting for your camera’s location.

5. Under Anti-dither, enter the anti-dither time. After a motion event occurs and motion
stops, if motion is detected within the anti-dither time, the system continues the motion
event and includes the new motion within the first event, rather than creating a new
motion event.

6. Under Post_REC, enter the time the system will record after a motion event occurs.

7. To configure a schedule when motion detection will be enabled on this channel, click
Setup next to Period. Configure times when motion detection will be enabled. For ex-
ample, you may want to disable motion detection during business hours and enable it
outside of business hours. Click OK when finished.

@ NOTE

This setting can override scheduled motion recording. This means that motion recording will only
take place at times that are enabled both in the Schedule menu and here.
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8. Configure the following system actions when motion is detected:

Alarm Out: Check the box to activate alarm output devices (not included) when the
selected channel detects motion. Select the alarm output devices will be activated
when motion is detected.

Latch: Enter the number of seconds an alarm output device will activate after mo-
tion is detected.

Show Message: Check to enable an on-screen pop-up when one of your cameras
detects motion. On-screen pop-up shows the channels an event occurred on and
the type of event.

Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™ Client.
Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
Channels: Select the channels that will record when motion is detected on the se-
lected channel.

PTZ Activation: Check to enable PTZ actions when motion is detected (PTZ cam-
era required; not included). Click Setup to select which PTZ actions will be taken by
each camera.

Buzzer: Check to enable the system buzzer.

Snapshot: Check to save a snapshot when the camera detects motion.

9. Click OK to save changes.

14.3.9 Configuring Video Loss Settings

Video Loss occurs if the system loses connection to one of the cameras.

To configure Video Loss settings:

1. From the Main Menu, click “ and then click Event>Motion>Video Loss.

MOTION
WARNING

Motion Detect

2. Under Channel, select the channel you would like to configure.
3. Check Enable to enable video loss events for the selected channel.
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5.

Configure the following to customize settings for video loss events:

Period: Click Setup to configure a schedule for video loss events. It is recom-
mended to leave this on the default setting, so you can be alerted at any time one of
your cameras loses video.

Alarm Out: Select the alarm output devices (not included) that will trigger when vid-
eo loss occurs.

Latch: Enter the number of seconds an alarm output device will activate after video
loss occurs.

Show Message: Check to show a popup message on the monitor if one of your
cameras loses video.

Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™ Client.
Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
Channels: Click the checkbox to enable video recording when video loss occurs.
You can then select the channels the system will record when video loss occurs on
the currently selected channel.

PTZ Activation: Check to enable PTZ actions when video loss occurs (PTZ camera
required; not included). Click Setup to select which PTZ actions will be taken by
each camera.

Post_REC: Enter the number of seconds the system will record after video loss
occurs.

Snapshot: Click the box to enable snapshot recording when video loss occurs. You
can then select which channels will save snapshots when video loss occurs on the
currently selected channel.

Buzzer: Check to enable the system buzzer when video loss occurs on the cur-
rently selected channel.

Click OK to save changes.

14.3.10 Configuring Alarm Input Devices

You can connect alarm input devices such as motion sensors (not included) or glass break
detectors (not included) to the system. The system can be set to trigger recording or take
other actions when these devices are activated.

To configure alarm input devices (not included):

From the Main Menu, click “ and then click Event>Alarm.

MOTION

ALARM
WARNING
ALARM OUTPUT

Net Alarm
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2. Configure the following to activate an alarm input device:

Alarm In: Select the alarm input port the device is connected to.

Enable: Check to enable the alarm input device connected to the selected port.
Type: Select Normal Open or Normal Close depending on the type of alarm input
device you have.

3. Configure the following system responses and parameters for the alarm input device:

Period: Click Setup to configure the times of the week when the selected device
will be activated. By default, the device will be activated 24/7.

Anti-dither: Enter the anti-dither time. After the device triggers, if it triggers again
within the anti-dither time, the system continues the event and includes the second
activation within the first event, rather than creating a new event.

Alarm Out: Check the box to activate alarm output devices (not included) and se-
lect the alarm output devices (not included) will be activated when the selected de-
vice is triggered.

Latch: Enter the number of seconds an alarm output device will activate after the
selected device is triggered.

Show Message: Check to enable an on-screen pop-up when the selected device
is triggered.

Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™ Client.
Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
Channels: Select the channels that will record when the selected device is
triggered.

PTZ Activation: Check to enable PTZ actions when the selected device is triggered
(PTZ camera required; not included). Click Setup to select which PTZ actions will
be taken by each camera.

Buzzer: Check to enable the system buzzer.

Snapshot: Check to save a snapshot.

4. Click OK to save changes.

14.3.11 Controlling Alarm Output Devices

You can connect alarm output devices (not included), such as sirens or strobe lights, to
the system. The Alarm Output menu allows you to enable or disable alarm output devices
and manually an activated device.

To access the Alarm Output menu:

1. From the Main Menu, click “ and then click Event>Alarm Output.

MOTION
ALARM
WARNING
ALARM OUTPUT
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To control alarm output devices:

* To enable alarm output devices, select Schedule or Manual for each device you would
like to enable. Select Stop to disable the alarm output device. Click OK to save
changes.

¢ To manually disable activated alarm devices, click OK under Alarm Release.

14.3.12 Configuring Hard Drive Warnings

Hard drive warnings will notify you if an issue is detected with the hard drive.

To configure hard drive warnings:

1. From the Main Menu, click “ and then click Event>Warning>HDD.

MOTION
WARNING

2. Under Event Type, select the hard drive event you would like to configure.

No Disk: No hard drive detected.

Disk Error: A hard drive error has been detected.

Disk Full: The hard drive is full or almost full. You can enter the percentage of disk
space remaining that will trigger a warning under Less Than (e.g. when less than
10% of the hard drive is empty, trigger a warning). Disk Full warnings will not occur if
overwrite is enabled.

All: Configure warnings for all hard drive events.

3. Configure the responses the system will take when the selected event occurs:

Show Message: Show a popup message on the monitor.

Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™ Client.
Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
Buzzer: Check to activate the system buzzer.

4. Click OK to save changes.

14.3.13 Configuring Network Warnings

Network warnings will notify you if there your system loses connection to the Internet or lo-
cal network or if there is an issue on your network.
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To configure network warnings:

1. From the Main Menu, click “ and then click Event>Warning>Network.

MOTION
WARNING

2. Under Event Type, select the event type you would like to configure.

* Net Disconnection: The system has lost connection to the network.

* IP Conflict: More than one device on your network has the same IP address.

¢ MAC Conflict: More than one device on your network has the same MAC address.
* All: Configure responses for all network events.

3. Configure the following for the selected event type:

¢ Enable: Check to enable the selected event type.

* Show Message: Check to show a popup message when the selected event occurs.

¢ Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).

e Buzzer: Check to activate the system buzzer.

¢ Record Channel: If Net Disconnect is selected, you can set the system to trigger
recording after it loses connection to the network. Check Record Channel to ena-
ble video recording and select the channels you would like to record. Set the
amount of time you would like the system to record under Post_REC.

4. Click OK to save changes.

14.3.14 Storage

The Storage menu allows you to configure the recording schedule and hard drives con-
nected to the system.

14.3.15 Configuring the Video Recording Schedule

You can set a custom recording schedule according to your needs. For example, you can
set the system to record continuously during business hours and record on motion detec-
tion only outside of business hours.

A custom recording schedule helps reduce the amount of hard drive space required, in-
creasing the time your system can retain recordings.

To configure the video recording schedule:

1. From the Main Menu, click “ and then click Storage>Schedule>Record.

2. Under Channel, select the channel you would like to configure or select All.
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3.

4.

Configure the schedule as needed:

SCHEDULE
HDD MANAGER
RECORD

* Check Continuous or MD (motion detection) to select the recording type you would
like to configure.

¢ Click and drag on each day to customize the recording schedule. The schedule is
set up as a grid, which each block representing one hour.

¢ Click next to All to link the recording schedules for all days. The icon for a day

changes to sl when days are linked. You can also click the boxes next to individ-
ual days to link them to each other. If the recording schedule is linked, changes
made to one of the days will apply to every day that is linked.

e Click u to disable all recording of the selected type on the selected day.

¢ Click E] if you need to set a more precise schedule down to the minute.

Click OK to save changes.

14.3.16 Configuring Pre-Recording

The system can pre-record video when motion detection events occur.

To configure pre-recording:

1.

wmn

From the Main Menu, click “ and then click Storage>Schedule>Record.

SCHEDULE
HDD MANAGER
RECORD

Under Channel, select the camera you would like to configure or select All.
Under PreRecord, select the duration for pre-recording.
Click OK to save settings.
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14.3.17 Configuring the Snapshot Schedule

You can set a schedule for recording snapshots from the cameras.

To set up the snapshot schedule:

1. From the Main Menu, click “ and then click Storage>Schedule>Snapshot.

SCHEDULE
HDD MANAGER
RECORD

Record

Channel (1

&
&
L]
o
-]
o
&

2. Under Channel, select the channel you would like to configure or select All.

3. Configure the schedule as needed:

Check Continuous or MD (motion detection) to select the recording type you would
like to configure.

Click and drag on each day to customize the recording schedule. The schedule is
set up as a grid, which each block representing one hour.

™
Click - next to All to link the recording schedules for all days. The icon for a day

changes to when it is linked. You can also click the boxes next to individual
days to link them to each other. If the recording schedule is linked, changes made
to one of the days will apply to every day that is linked.

Click u to disable all recording of the selected type on the selected day.

Click E] if you need to set a more precise schedule down to the minute.

4. Click OK to save changes.

14.3.18 Configuring Holidays

You can set certain days as holidays. Holidays have a special recording schedule.
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To configure holidays:

1. From the Main Menu, click “ and then click Setting>General>Holiday.

UPGRADE

2. Click Add New Holidays.
3. Configure the following:

Add New Holidays

bl ol

¢ Holiday Name: Enter a name for this holiday.
* Repeat Mode: Select Once Only for the holiday to occur only this year or All-Year

for the holiday to be repeated each year.
* Holiday Range: Select Date to select a specific date, or select Week to select holi-

days based on which week they fall on.

4. Click Add. Now that you have added a holiday, an extra holiday setting is added to the
recording schedule.

|_§p| NOTE

You cannot delete holidays, but you can disable them by selecting Stop under the Status drop-down
and then click Apply.

14.3.19 Formatting the Hard Drive

The HDD Manager menu allows you to format the hard drive. If you install a new hard
drive, you must format the hard drive using the system before you will be able to record.

To format the hard drive:

/\ cauTion

Formatting the hard drive erases all data on the hard drive. This step cannot be undone.
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2.

3.

From the Main Menu, click “ and then click Storage>HDD Manager.

SCHEDULE
HDD MANAGER
RECORD

Select the hard dive you would like to format and then click Format. Click OK to
confirm.
Click OK to save changes. The system will restart to complete the formatting process.

14.3.20 Configuring Hard Drive Type

The system supports the following hard drive types:

Read-write HDD: Normal recording hard drive.

Read-only HDD: The system can playback data from this hard drive, but it will not re-
cord to it.

Mirror HDD: The hard drive will be used for mirror recording only. You must set up mir-
roring recording before this feature will work.

To set the hard drive type:

1.

From the Main Menu, click “ and then click Storage>HDD Manager.

SCHEDULE
HDD MANAGER
RECORD

Type
Read-write HDD

Refresh Format

2. Click the hard drive you would like to configure.
3. Under Type, select Read-write HDD, Read-only HDD, or Mirror HDD.
4. Click OK to save changes. The system will restart to complete this operation.

14.3.21 Setting up Hard Drive Mirroring (Advanced)

A mirror hard drive can be used to automatically backup video footage recorded to the re-

cording (read-write) hard drive. When a mirroring hard drive is installed, the system can be
set to record cameras in parallel to both the recording hard drive and the mirror hard drive.
This way, the footage is automatically backed up if the recording hard drive fails.
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How hard drive mirroring works:

1. Security system.
2. Primary hard drive.
3. Mirror hard drive.

@ NOTE

* The mirror hard drive must be as large or larger than primary hard drive to backup all recordings.

* HDD mirroring begins from when mirror hard drive is installed and configured.

* Two hard drives must be installed in the system to use HDD mirroring. For details on installing hard
drives, see 20 LNR400 Series Hard Drive Installation, page 160.

To set up hard drive mirroring:

1. From the Main Menu, click“ and then click Storage>HDD Manager.
2. Click the Type drop-down under the second hard drive and select Mirror HDD.

SCHEDULE
HDD MANAGER
HDD ADVANCE
RECORD

i
Read-write HDD
Read-only HDD
Mirror HOD \

Refresh Format

Cancel

/\  cauTion

Setting a hard drive for mirroring erases all data on the hard drive. This step cannot be undone.

3. Click OK to apply changes. Click Yes to confirm. The system will format the hard drive
and restart.

4. When the system restarts, click “ and then click Storage>Schedule>Record.
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5. Under Channel, select the channel you would like to enable for mirror recording, then
check Mirroring. Repeat the process for any additional channels.

SCHEDULE
HDD MANAGER
HDD ADVANCE
RECORD

Snapshot

~| PreRecord 4 sec. 4 Mirroring

&
&
&
&*
&
&
L]

Default Copy oK Cancel

6. Click OK to save changes.

14.3.22 Configuring Hard Drive Groups (Advanced)

Hard drive groups allow you to balance recordings across multiple hard drives. For exam-
ple, you can record channels 1~4 to one hard drive and 4~8 to a second hard drive. This
can reduce the amount of wear on the hard drives and may extend the life of the hard
drives.

E nore

e Two hard drives must be installed in the system to use hard drive groups, and both hard drives must
be formatted as Read-write hard drives. For details on installing hard drives, see 20 LNR400 Series
Hard Drive Installation, page 160.

To configure hard drive groups:

1. From the Main Menu, click “ and then click Storage>HDD Advance>HDD
Setting.

2. Under HDD Group, assign a group to each hard drive. To set up two hard drive
groups, assign one hard drive to group 1 and the other to group 2.

SCHEDULE
HDD MANAGER
HDD ADVANCE
RECORD

Main Stream  Sub Stream  Picture

3. Click OK. The system will restart to apply changes.
4. When the system restarts, you must decide which channels will record to each hard
drive group.
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5. From the Main Menu, click “ and then click Storage>HDD Advance>Main
Stream. For each channel, select the hard drive group you would like to record the
main stream (high quality) video and then click Apply.

HDD ADVANCE
RECORD

HDD Seting Sueam | SubSteam  Picture

SetAl - Apply to al

Cancel

6. Click the Sub Stream tab. For each channel, select the hard drive group you would
like to record the sub stream (reduced quality) video and then click Apply.

SCHEDULE
HDD MANAGER

HDD Seting  Main Stream | S 1| Picre

HDD ADVANCE i 3 Apply to al

RECORD

7. Click the Picture tab. For each channel, select the hard drive group you would like to
record snap shots and then click Apply.

SCHEDULE

HDD Setting  Main Stream  Sub Stream
HDD MANAGER
HDD ADVANCE : 1 5 Apply o all

RECORD

Cancel

14.3.23 Configuring General System Settings

You can use the General menu to configure miscellaneous system settings.
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To configure general settings:

1. From the Main Menu, click “ and then click Setting>General>General.

GENERAL
DISPLAY
RS232

Date&Time Holiday

PANITILTIZOOM
ACCOUNT anguage ENGLISH -
Conlig Backup NTSC

DEFAULT Overwrite
UPGRADE

2. Configure the following:

¢ Device Type: Shows the model number of your system.

¢ Device No.: Select the remote control address of the system. See , page .

* Language: Set the system languages. Available options are English, French, and
Spanish.

¢ Video Standard: Select NTSC (North America) or PAL (Europe).

* HDD Full: Select Overwrite for the system to overwrite the oldest recordings when
the hard drive is full or select Stop Record for the system to stop recording when
the hard drive is full.

* Pack Duration: Select how the duration (in minutes) the system will store video
files. For example, if this is set to 30 minutes, the system will create a new video file
for each 30 minutes of continuous recording.

¢ Instant Playback: Select the amount of time (in minutes) the system will go back
when instant playback is activated in live view.

¢ Auto Logout: Select the idle time (in minutes) before the system will logout the cur-
rent user.

¢ Navigation Bar: Check to enable the Navigation Bar that comes up when you left
click in live view.

» Startup Wizard: Check to enable a setup wizard when you start up the system.

¢ Mouse Speed: Use the slider to adjust the mouse speed.

3. Click OK to save changes.

14.3.24 Setting the Monitor Resolution (Display)

The Display menu allows you to configure the systems monitor resolution and other dis-
play settings.
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To set the monitor resolution:

1. From the Main Menu, click “ and then click Setting>Display>Display.

GENERAL
DISPLAY

RS232
PAN/TILT/ZOOM
ACCOUNT

Config Backup

DEFAULT
UPGRADE

2. Under Resolution, select the correct resolution for your monitor: 1920x1080,
1280x1024, 1280x720, or 1024x768.

3. Click OK to save changes. Click OK again to restart the system using the new
resolution.

To configure other display settings:

1. From the Main Menu, click “ and then click Setting>Display>Display.

GENERAL
DISPLAY

RS232
PANTILT/ZOOM
ACCOUNT
Config Backup
DEFAULT
UPGRADE

2. Configure the following:

e Transparency: Select the menu transparency.

¢ Time Display: Check to show the time on the monitor.

¢ Channel Display: Check to show the channel names on the monitor.

* Image Enhance: Check for the system to digitally improve the video quality on the
live display. This setting does not affect recordings.

3. Click OK to save changes.

14.3.25 Saving Your System Configuration to a USB Thumb Drive

The system allows you to save your current system configuration to a USB thumb drive
(not included). This is useful if you want to backup your current settings.

@ NOTE

This function only saves settings created in system menus. It does not save or backup any video.
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To save your system configuration to a USB thumb drive:

1. Insert a USB thumb drive (not included) into one of the USB ports.

2. From the Main Menu, click“ and then click Setting>Config Backup.

GENERAL

Conlig Backup
DEFAULT

UPGRADE

Format | | IMPORT | | EXPORT

3. Under Device Name, select the USB device where you would like to save the
configuration.
4. Click EXPORT to save your current system configuration.

To restore a saved system configuration:

1. Insert a USB thumb drive (not included) with a saved system configuration into one of
the USB ports.

2. From the Main Menu, click“ and then click Setting>Config Backup.

GENERAL
DISPLAY.

ac)
DEFAULT
UPGRADE

Fommat | | IMPORT | | EXPORT

3. Under Device Name, select the USB device.

4. Click the folder with the configuration files you would like to restore. Configuration file
folders are labeled “Config” and then the time and date the configuration was saved (e.
g. Config_20140425103727).

5. Click IMPORT to restore the system configuration.

6. Click OK to confirm. The system will restart to complete the operation.

14.3.26 Setting the System to Factory Defaults

The Default menu allows you to reset the system to factory default settings.
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To reset the system to factory default settings:

1. From the Main Menu, click “ and then click Setting>Default.

GENERAL
DISPLAY

RS232
PAN/TILT/ZOOM
ACCOUNT

ARREE

Config Backup

DEFAULT
UPGRADE

2. Check the menus you would like to reset to default settings.
3. Click OK.

14.3.27 Upgrading Firmware from USB

Firmware upgrades provide enhanced functionality. The system will automatically check
for firmware upgrades if it is connected to the Internet. The system also supports firmware
upgrades from a USB thumb drive (not included).

To upgrade firmware from a USB drive:

1. Download the firmware upgrade from www.lorextechnology.com/support.
2. Extract the firmware file and copy the firmware to a blank USB thumb drive.

@ NOTE

Do not have any folders on the USB thumb drive—just the firmware file.

3. Insert the USB thumb drive to a USB port on the system.

4. Right-click and then click Main Menu. Click “>Setting>Upgrade.

GENERAL
DISPLAY

RS232
PANTILTIZOOM
ACCOUNT
Config Backup.
DEFAULT
UPGRADE

5. Click Start.

#L.X400021; r.29578/29578; en-US 75




14

Using the Main Menu

6. Select the firmware file on the USB drive and click Start.

& WARNING

DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING FIRM-
WARE INSTALLATION
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14.4 Shutdown
Use the Shutdown menu to shutdown, restart, or log out of the system.
To access the Shutdown menu:

1. From live view, right-click and select Main Menu.
2. Enter the system User Name (default: admin) and Password (default: 000000) and
click OK.

3. Click E>Shutdown.

4. Select one of the following:

SHUTDOWN

O A

Shut Down Logout Restart

¢ Logout: Log out the account that is currently active.
e Shutdown.
* Restart.
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Connecting to Your System Over
the Internet on PC or Mac

This system features connectivity using the exclusive FLIR Cloud™. This cloud-enabled
service allows for Internet connectivity without requiring any network configuration. Up to 3
devices may connect to the system at the same time.

@ NOTE

page 109.

* Except where noted, the PC and Mac instructions in this section are the same.
* For smartphone/tablet setup, see 17 Connecting to your System Using Smartphone or Tablet Apps,

* For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

15.1 System Requirements

Your system must meet the system requirements below:

Description

Requirement

CPU

Core 2 Duo 3.0GHz

Operating System

Windows™ 8/7/Vista
Mac OSX 10.7 and above

Memory 2GB

Video 512 MB of video memory and above
Network (LAN) 10/100 BaseT Network

Network (WAN) 1 Mbps upstream

High-speed Internet service is required to remotely
connect to your system.

15.2 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system.
Connect the other end of the Ethernet cable to an empty LAN port (usually numbered

1~4) on your router.
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3. Reconnect the power adapter to power the system back on.

20900n -
' RIGLCIOG TR oy

Security System
(may not be exactly as
shown)

Internet Computer

(not required for
local viewing)

15.3 Step 2 of 3: Obtain the system’s Device ID

The Device ID is a unique code that allows your system to handshake with FLIR Cloud™
servers for a secure connection over the Internet.

To find the Device ID:

1. The Device ID is located on a sticker on the system.
2. Write down the Device ID of the system.

15.4 Step 3 of 3: Connect to the System Over the Internet

Follow the steps below to connect to the system over the Internet.

@ NOTE

Make sure to upgrade your system to the latest firmware version. You must have the latest firmware
and client software to connect to the system over the Internet.

To connect to the system over the Internet:
1. Download and install the client software.

e PC Users: Download and install the Client Software for PC from
www.lorextechnology.com/support.

e Mac Users: Download and install the Client Software for Mac from
www.lorextechnology.com/support. Double click to extract the software. Then, drag
the software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (#==") from the
desktop or Applications list.

#L.X400021; r.29578/29578; en-US 79



15

Connecting to Your System Over the Internet on PC or Mac

3. Log into the Client Software using the Client Software user name (default: admin) and
password (default: admin) and then click Login.

SFLIR

User Name: admin

- ssses
Remember Password

( togn | ([ Exit |

4. Click Add Device.

5. Enter the following:
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Input Info

Device Name: HD n onvif

Group Name: efault G p ﬂ By IP/Domain

Type: ) ﬂ

Device ID:

Retrieve Info

Device Informaton —MM

5.1.
5.2.
5.3.
5.4.
5.5.

(posviore oo Y corcer |

Device Name: Choose a name for your system of your choice.
Device ID: Manually enter the Device ID printed on the label.
Client Port: Enter the Client Port (default: 35000).

User Name: Enter the system User Name (default: admin).
Password: Enter the system Password (default: 000000).

6. Click Add. If this is the first time you are connecting, you will be prompted to change
the system password.

7. Enter a new 6 character password and click OK. This password will be used to con-
nect to your system from now on.

Please update your system's password.

[

8. Click - then .
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9. Click and drag Default Group to the display window to open your cameras in live view.

Congratulations! You can now connect over the Internet to view and playback video
on your computer.

{Bont
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Using FLIR Cloud™ Client for PC
or Mac

FLIR Cloud™ Client allows you to connect to multiple systems from a PC or Mac.

16.1 Home Page

The Home Page allows you to access all the tabs within the software. Each tab allows you
to access different features.

To open tabs:

Click a tab from the Home Page to open it or click the button at the top of the screen
from within any tab to open a new tab.

16.2 Live View
The Live View tab is where you can view live video from connected systems.

To view live video from a system:

-
1. Click and then click to create a Live View tab.

2. Click and drag a DVR, NVR, group, or individual camera to open live video. To access
individual cameras, you can click + to expand groups or systems.

/’-f, =

e L

CAM

(e 1157 ‘le‘
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16.2.1 Live View Controls

1. Live display: Double-click to expand the area. Right-click to access additional options.
Hold the mouse over the display area to access the camera toolbar.

DoddO0D

1.1.  Streaming quality: Shows the bitrate and resolution for the stream, and shows
if display is showing the Sub Stream or Main Stream.

1.2. Manual recording: Click to start/stop manual recording.

1.3.  Snapshot: Click to save a snapshot.

1.4. Mute/unmute: Click to mute/unmute audio (audio camera required).

1.5. Not supported.

1.6. Instant playback: Plays back the most recently recorded video from the cam-
era. By default, it will play back the last 5 minutes of recorded video from the
camera.

1.7.  Digital zoom: Click to enable digital zoom mode. Click and drag over the dis-
play area to zoom on the camera. Then click and drag to pan. Click the icon
again to zoom out.

1.8. Disconnect.

Camera toolbar:

Sub Stream(205kbps, 352%240)

1. Split-screen mode: Click to select split-screen layout.

2. Aspect ratio: Use the drop down menu to select the aspect ratio for the selected
camera. Original uses the actual aspect ratio of the image. Full-win stretches the im-
age to fill up the entire display area.
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3. E Full-screen: Click to open full-screen mode. Press ESC to exit full-screen mode.

i
4, e Save view: Click to save the current display layout and open cameras as a view.
Then enter a name for the view.

5. . Start/stop tour: Click to start the tour. During the tour the client will cycle through
all saved views every few seconds. Click again to stop the tour.

6. PTZ Controls: Controls for PTZ cameras (not included). See 16.3 Controlling PTZ
Cameras, page 86 for details.

7. View: Click View to access view menu. Then double-click on a view to open it in the
display area.

Device N
View ~

li Viewl

[ =
l. View2

8. Devices: Shows a list of groups, cameras, and systems connected to the client. Drag
items to the display area to open live video. Right-click to view additional options.

16.2.2 Opening Live View in Multiple Monitors

If your computer has multiple monitors, you can open more than one Live View tab and
move them to secondary monitors. This allows you to monitor cameras on multiple moni-
tors at the same time.

@ NOTE

Using multiple monitors significantly increases the amount of computing resources necessary to run the
application and may affect performance.

To open Live View in multiple monitors:

-
1. Click and then click to create a Live View tab.
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2. Click and drag the tab outside of the client window to create a new window. You can
drag the window to one of the secondary monitors.

16.3 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the client.

@ NOTE

You must ensure the PTZ camera is properly connected to your system and your system is configured to
detect it before you can control them using the client.

To control PTZ cameras:

* Click the display area with the PTZ cameras and use the on-screen PTZ controls.
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PTZ controls:

1. Open menu: Click to open camera OSD menu controls. This feature may not be sup-

ported for all camera models.

2. Move camera: Click the arrows to move the camera.

Click B8 to open dynamic zoom mode. Then click and drag in the video area to zoom

in the camera on an area.

Zoom +/-: Click to zoom the camera in and out.
Focus +/-: Click to increase/decrease the focus.
Iris +/-: Click to increase/decrease the iris.
Advanced: Click to access advanced PTZ controls.

ook w

16.3.1 PTZ Presets
Presets will save a camera position for quick retrieval.

To add presets:

1. Click - to open the Advanced controls. Select Preset.

2. Click .
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3. Select the number of the preset you would like to add.

4. Move the camera to the desired position.

5. Click - to save the current position as a preset.

To go to a saved preset:

1. Select the preset number from the list or click . to go to the currently selected
preset.

16.3.2 PTZ Tours
Tours will cycle through a set of presets.

To configure a PTZ tour:

1. Click - to open the Advanced controls. Select Tour.

2. Click .

3. Under Cruise ID, select the number of the tour you would like to configure.
4. (Optional) Under Cruise Name, enter a name for the tour.
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5. Use the chart to select which presets you would like to include in the tour and the order
of presets.

Tour List

Cruise Name

Time(s) Operation

10

10

¢ Preset: Select the preset number.
¢ Time(s): Enter the time in seconds the camera will remain on the selected preset.

e Operation: Click . to add a preset to the tour. Click . to delete a preset from
the tour.
6. Click OK to save changes.

To run a PTZ tour:
1. Select the tour number and click .

16.3.3 PTZ Pattern
Patterns automatically cycle the camera between two positions.

To create a pattern:

1. Click - to open the Advanced controls. Select Pattern.

2. Select the number of the pattern you would like to set up.

3. Move the camera into the desired start position.
4. Click - to start recording the pattern.

5. Move the camera to the desired end position. Then, click - to stop recording the
pattern.

To run a pattern:

1. Select the pattern number and click .
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16.3.4 PTZ Scan
Scan automatically cycles between a left and right point.

To set up scan mode:

1. Click - to open the Advanced controls. Select Scan.

2. Move the camera to the desired left position and click .

3. Move the camera to the desired right position and click -

To run scan mode:

1. Click .

16.3.5 PTZ Pan
Pan makes the camera continuously pan 360°.

To run Pan mode:

1. Click - to open the Advanced controls. Select Pan.

2. Click .

16.4 Playback
You can use Playback mode to playback video saved on systems connected to the client.

To access Playback mode:

o
e Click and then click 2 to create a Playback tab.
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To playback video:

—_

Check the channels you would like to play back from in the Device List.
2. Under Type, check the file types you would like to search for.

e All: All recordings.

¢ General: Continuous recordings.

e MD: Motion recordings.

e Alarm: Alarm recordings. Your system must support alarm devices (not included) to
use this feature.

3. Under Stream, select Main Stream to search for Main Stream recordings (high qual-
ity) or Sub Stream to search for Sub Stream recordings (smaller file size).

4. Select the start time and end time for your search under From and To. You may not
search more than 24 hours of video.

5. Click Search. Wait for the client to find video saved to the system.

6. Click inside the play back bar to start playback.
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16.5 Playback Controls

o

15.

o

HOME PAGE PLAYBACK i 1) VICES ADD

041301217 11 01

Display area: Double-click to expand/return to split-screen mode. Hold the mouse
over the display area to open the camera toolbar.

="

Main Stream(1730.74 kb/s, 1280%720)

. E Snapshot: Click to save a snapshot.

J Digital zoom: Click to enable digital zoom mode. Then, click and drag to zoom
in. Click and drag to pan the camera. Click again to zoom out.

Event: Click to view recordings based on a list of events and files.

Record: Click to view recordings on a timeline.

Sync: Click to sync playback between channels. This forces all channels to playback
from the same time.

Pause/play.

Stop.

Frame-by-frame: Click to advance the video by a single frame.

Playback speed: Use the slider to adjust the playback speed.

Mute.

. Volume.

. Split-screen: Select split screen configuration.

. Full-screen: Click to open playback in full-screen. Press ESC to exit full-screen.

. Timeline zoom: Use the slider to zoom in/out on the timeline.

. Playback timeline: Shows recordings from the selected channels on a timeline. Click

inside the timeline to start playback or select a playback time. Each type of recordings
is shown in a different color. Continuous recordings are green, motion recordings are
yellow, and alarm recordings are red.

Video clip: Click to start a video clip. You can download video clips to your hard drive.
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16. Download list: Click to see a list of files you have downloaded and the progress of
files that are currently downloading.

17. Search: Search for video on the selected channels based on the search parameters
you set.

18. Device list: Select the channels you would like to search or playback video from.

16.6 Downloading Video to your Computer Hard Drive

You can download video to your computer hard drive to save important events or share
them. It is recommended to download video of important events as soon as possible to en-
sure they are not overwritten by new recordings.

@ NOTE

PC Users: You may need to run FLIR Cloud™ Client as an administrator to download files to your hard

drive.

To download video files:

1. Start playing back video using the steps in 16.4 Playback, page 90.

2. Click . to start a video clip at the current playback time. Click . to stop the video
clip.

3. Configure the following save options:

Export Setup

Path ACloudCli

File Format AVI

El Download Video Player

s e (QETED

* Path: Use the default save folder or click Browse to select a different folder.
¢ File Format: Select Original Format to save to .dav format (requires the video
player). Select AVI to save files to .avi format (can be played in VLC Media Player).

@ NOTE

The Mac version only supports downloading video to .dav format.

* Download Video Player: Check to save a copy of the video player with the down-
loaded file.

4. Click OK to start the download. A status screen will pop up to show progress on down-
loaded files.
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E note

To retrieve downloaded video files:

e PC Users: Browse to the folders listed in General>File.

¢ Mac Users: Browse to the folders listed in General>File. To get to the default location, open Applica-
tions in Finder, right click on FLIR Cloud Client and select Show Package Contents. Then, navigate
to the desired folder.

eone i Applications
‘\q\\ \ESEWI"“H #Frll=][om] Q
FAVORITES lame + Da
2} Niles =5 —

= Open §

| My Files < Flir MAC Player
N Font Book Show Package Contents

CPEEE # Game Center

& FLIR Cloud Client

Move to Trash

[E Desktop O iBooks b

[ Documents 2 Image Capture Get Info 0

€) Downloads B s Compress "FLIR Cloud Client” »

b= @ unes Burn “FLIR Cloud Client” to Disc... ¥
16.7 Alarm

The Alarm menu allows you to view a list of alarms received by the client software.

@ NOTE

You must set up alarms in the Alarm CFG menu before they will appear in this list. See 16.12 Alarm CFG,
page 99 for more details.

To access Alarms:

[N
¢ Click and then click .

Alarm menu overview:

1. Number of alarms: Shows the number of open alarms.

2. Alarm list: Shows the list of alarms and information on when they occurred and which
systems and channels triggered them.

3. Alarm Process: You can close alarms by selecting one of the options and clicking OK.
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4. Options: Check to enable the following:

* Display Link Video: Open live video to monitor alarms on a continuous basis.
* Display Overlay Window: Show the overlay controls. They allow you to enable/dis-
able sound alerts and quickly jump back to the Alarm menu from another tab.

* Pause Refresh: Stop refreshing the live video in the video popup.

16.8 Log

The Log menu allows you to view logs for the client software or to view logs for connected
systems.

To access logs:

e Click - and then click .

To view client logs:

1. Click Client Log to view logs for the client software.

2. Configure the following:

¢ Start Time/End Time: Select the start and end times to search for logs.
* Log Type: Select the type of logs to search for.

3. Click Search.

To view logs from connected systems:
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1. Click Device Log to view logs from connected systems.

2. Configure the following:

¢ Start Time/End Time: Select the start and end times to search for logs.
* Log Type: Select the type of logs to search for.
* Device Name: Select the system you would like to view logs from.

3. Click Search.

16.9 E-map

E-Map allows you to place cameras over a still image. For example, you can use the E-

Map to create a virtual map of your cameras over a floor plan of your home or business.

To create an E-map:

1. Click and then click ﬂ

2. Click Add Map.

Gk Adato setup an £tap (| 4 AdSMap
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3. Configure the following:

| Addvap. e

Name: Home

Picture: W { -Fffe

e R

Save | [ Cancel )

¢ Name: Enter a name for your e-map of your choice.

¢ Picture: Click File and then select a .png, .bmp, or .jpg image on your computer to
use as the e-map.

¢ Describe (optional): Enter a text description of the e-map.

4. Click Save.
5. Click Edit to edit the e-map.

To open cameras from the e-map:
1. Click View.
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2. Double-click cameras on the map to open live video.

16.10 Devices
The Devices menu is where you can manage systems connected to the client software.

To access the Devices menu:

¢ Click and then click .

Devices overview:

1. Devices Found: Shows systems that are connected to the same network as the com-
puter where the client is installed. Once you connect to the system, it moves to the bot-
tom of the screen.

Search: Refresh the list of systems connected to the network.

Add: Add checked systems to the client software.

Device list: Shows a list of systems connected to the client software, and shows which
systems are online.

Add Device: Add a remote system using a Device ID or IP/DDNS address.

Delete: Delete the selected system.

Import: Import a list of systems from a saved .xml file.

Export: Export a list of currently connected systems to an .xmil file. This is useful if you
need to re-install the software or if you want to open the same list of systems on a dif-
ferent computer.

9. Delete: Delete system.

10. Manual connect/disconnect: Manually connect/disconnect the system.

pOD

© N O
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11. Edit: Edit the connection details for the system.

16.11 Device Config
The Device Config menu allows you to remotely configure settings for connected systems.

To access the Device Config menu:

e Click and then click Hes

* Click on a system in the device list to see the settings available for that system and then
configure settings as needed.

|_§P| NOTE

The settings available depend on the model of system you have.

16.12 Alarm CFG

The Alarm CFG menu allows you to configure alarms for the client software. The client
software will alert you by popping up live video and playing sound alerts.

@ NOTE

Alarm upload must be enabled on the system in order for it to send the alarm to the client software.

To create alarms:

1. Click and then click E=

2. Click Add to create a new alarm.
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3. Inthe Alarm sources menu, you set up the parameters that trigger the alarm.

¢ Under Alarm Type, select the alarm type that will trigger an alarm. For example,
you can select Motion Detect for the alarm to be triggered by motion.

* Select the systems or channels you would like to trigger an alarm. Continuing the
example, if CAM 1 is selected, the alarm will be triggered if there is motion on CAM
1.

¢ Click Next.
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4. Inthe Alarm link menu, you set up the responses to alarms. Select the channels that
will pop up or alarm out devices (not included; not all systems support alarm out devi-
ces) that will be triggered by an alarm.

For each channel selected, configure the following:

below.

¢ Record: Record video from the selected channel.

E ot

PC Users: You may need to run the client software as admin to record.

¢ Preset: If you select a PTZ camera, you can select the preset that will be activated
when an alarm occurs.

* Stay Time: Enter how many seconds the video window will stay open or record
when an alarm occurs.

5. Click Next.
6. Inthe Period window, configure times the alarm will be activated.

7. Click Confirm to save the alarm.
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To manage alarms:

Oseration

@
@
®
@
®

Export: Export current list of alarms as an xml file.
Import: Import list of alarms.

Delete: Delete selected alarm.

Add: Add new alarm.

Alarms.

On/off: Click to enable/disable alarm.

Delete: Click to delete alarm.

Edit: Click to edit alarm settings.

i R o o

16.13 Tour & Task

The Tour & Task menu is where you can set up custom views for the system. You can also
set up tours, which sets the client to automatically cycle through views.

To start a tour:
e Click - in Live View to start a tour. The live view will automatically cycle through all
views you have set up in the Tour & Task menu. Click again to stop the tour.

To add views:

1. Click and then click E8,

2. Click + to create a new view.
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3. Under Name, enter a name for your view.

4. Under Stay Time, enter the number of seconds the view will be shown before the cli-
ent switches to the next view.

5. Select the split-screen mode you would like to use for the view and then click and drag
channels to the empty grid areas to select channels to be shown in the view.

Cocomore IO sove N corce )

6. Click Save to save the view. Or click Add More to save the view and create another
view.
16.14 Account

The Account menu is where you can set up user accounts and passwords for the client
software. To simplify management, you can group user accounts according to role. A role
determines the permissions an individual user account can have.

To access the account menu:
¢ Click - and then click n

16.14.1 Managing User Accounts

By default, the client software includes an admin account that has full access to all fea-
tures of the software and all connected systems. You can add user accounts with custom-
ized levels of access.

@ NOTE

The admin account cannot be deleted. The default user name for the admin account is admin and the
default password is admin.
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To create a user account:
1. Click Add.

Password Confirm Password

Remarks

User Rights [l Channel List

Cancel

e User Name: Enter a user name for the account.

* Role: Select the role for the user account. By default, the user account gains all the
permissions of the role selected, but you can deactivate permissions as needed.

¢ Password/Confirm Password: Enter the password for the user account.

¢ Remarks (Optional): Enter a text description of the user account.

¢ User Rights: Check the permissions that will apply to the user account. If you click
on LiveView, Playback, and PTZ, you can select which channels the user account
can access in the Channel List section.

3. Click Save to create the account.

To switch between user accounts:

* Click B

To modify a user account:

E norme

Admin accounts with Account Setup permissions can change account passwords. A user cannot change
his own password.

* Click . next to the user account you would like to modify. Edit the user account de-
tails and click Save.
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To delete a user account:
1. Click - next to the user account you would like to delete. Click OK to confirm.

16.14.2 Managing Roles

Roles make it easier to manage user accounts by determining the permissions an individu-
al user account can have. By default, a new user account is given all the permissions of
the role they are assigned to.

To create a role:

1. Click the Role tab.
2. Click Add.

3. Configure the following settings for the role:

s me

Remarks

Role Rights 1Al ¥ Channel List

* Role Name: Enter a name for the role.

* Remarks (Optional): Enter a text description of the role.

* Role Rights: Check the permissions that will apply to user accounts assigned this
role. If you click on LiveView, Playback, and PTZ, you can select which channels
may be accessed in the Channel List section.

4. Click Save.

To modify a role:

e Click . next to the role you would like to modify. Edit the role details and click Save.
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To delete a user account:

1.

Click - next to the role you would like to delete. Click OK to confirm.

16.15 General

The General menu is where you can configure application settings for the client software.

To access the General menu:

Click and then click =%

16.15.1 Basic

The Basic menu contains general settings for the client software.

The Basic menu contains the following settings:

Log Saved Time: Select the number of days you would like the client to save log
entries.

Instant Playback Time: Select the number of minutes the system will go back when
you start an instant playback.

Network Capability: Select the speed of your computer’'s network connection.
Resume Live View State: Check for the client to resume live view when it starts up.
The live view will open to the last view that you had open.

Auto login application: Check for the client to automatically login when it starts up
without entering a user name or password.

Auto Login Windows: Not supported.

Language: Select the language for the client software.

Sync Time: Check to have the client software sync time with your computer’s system
time. Select the time the software will sync the time. Click Sync Now to manually sync
the time.

Time Format: Select 12-Hour or 24-Hour time format. You must close the client and
restart it to apply this setting.

@ NOTE

Click Save to save setting changes.

16.15.2 File

The File menu allows you to select the folders where the client software will save down-
loaded video files and snapshots.
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The File menu contains the following options:

¢ Snapshot Path: Click Browse to select the default folder to save snapshots.

* Record Path: Click Browse to select the default folder to save video recordings.

¢ Config Path: Click Browse to select the folder where the client will save software con-
fig files.

E note

Click Save to save setting changes.

PC Users: You may need to run the client software as admin to save files to enable snapshot or video
recording.

16.15.3 Alarm Prompt

The Alarm Prompt menu allows you to configure audio alerts. The client will play audio
alerts when events occur. You can replace the default sounds with any .wav file.

@ NOTE

You must configure alarms in the Alarm CFG menu before the client will play alarm sounds.

The Alarm Prompt menu has the following options:

¢ Open Audio: Check to enable audio alerts.

¢ Loop: Check to repeat audio alerts until acknowledged.

e Camera Masking: Select or preview the sound that will play for camera masking
alarms.
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* Motion Detect: Select or preview the sound that will play for motion detection.

¢ Video Loss: Select or preview the sound that will play for video loss alarms.

¢ Disk Full: Select or preview the sound that will play for disk full alarms.

¢ Disk Error: Select or preview the sound that will play for disk errors.

e External: Select or preview the sound that will play for external alarms (triggered by
sensor devices, which may not be supported on all systems).

¢ E-map flashes when alarm occurs: If the camera has alarms enabled and is added

to an e-map, a A appears on the e-map when an event occurs.

@ NOTE

Click Save to save changes.

16.15.4 Version

The Version menu shows you which version of the client software you are using. It is rec-
ommended to always run the latest version of the software from
www.lorextechnology.com/support.

FLIR Cloud Client
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The system is compatible with iPhone, iPad and Android devices.

Platform App Name Get App From
iPhone/iPad FLIR Cloud™ Apple App Store
Android FLIR Cloud™ Google Play Store

See www.lorextechnology.com/support for the latest list of supported apps and devices.

17.1 iPhone

FLIR Cloud™ is an iPhone app that allows you to remotely view your system.

17.1.1 Prerequisites

e Connect your system to your router using an Ethernet cable (included).
¢ Make sure to upgrade your system to the latest firmware version. You must have
the latest firmware and mobile apps to connect to the system over the Internet.

@ NOTE

For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

@ NOTE

The app will ask for permission to send push notifications and to access Photos. It will only send notifi-
cations if you enable motion-activated push notifications in the Push Config menu. It needs access to
Photos to save snapshots and video clips to the local storage on your mobile device.

17.1.2 Connecting to your System on iPhone

1. Download FLIR Cloud™ for free from the App Store.

N
2. Tap on the FLIR Cloud™ icon () to start the app.

3. Tap Sign up and enter your email address and password to create a new account.

4. Tap then .

Live View

5. Configure the following:
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Live View:

Playback

5.1.

5.2.
5.3.
5.4.
5.5.

EXAMPLE

CONNECT

Tap Scan QR Code and line up the QR code on the top of your system using
the camera on your mobile device.
OR

Under Device ID, manually enter the Device ID printed on the label.

Name: Choose a name for your system of your choice.

Client Port: Enter the Client Port (default: 35000).

User Name: Enter the system’s User Name (default: admin).
Password: Enter the system’s Password (default: 000000).

6. Tap Connect. You will be prompted to change the system password.
7. Enter a new 6 character password and tap OK. This password will be used to log on to
your system from now on.

8. Theap

p opens in Live View and streams video from your cameras.

17.1.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

Live View

Overview

mountainview-.. & * mountaif View-.. & * mountainview-F.. & *

1. Menu:

Tap to bring up the Menu.
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S ©®oN

Display Area: Double-tap to open a channel in full screen. Swipe left or right to select
a different page of channels.

Pages: Shows the number of pages available and highlights the currently selected
page.

Split: Select the split-screen layout.

Snapshot: Tap to take a snapshot from the currently selected channel.

Control Bar: Contains the following options. Swipe left or right to access more options.

6.1. Quick Playback: Tap to start/stop quick playback.

6.2. PTZ Controls: Open/close PTZ controls. PTZ camera required (not included).
6.3. Streaming Quality: Open/close streaming quality panel.

6.4. Not supported.

6.5. Not supported.

6.6. Not supported.

6.7. Digital Zoom: Tap to activate digital zoom mode. Pinch to zoom in/out.

6.8. Color Settings: Tap to access color controls for the currently selected camera.

Manual record: Tap to start/stop manual recording.
Access Favorites.
Connect/disconnect all: Connect to/disconnect from all previously added cameras.

. Device List: Tap to open a list of devices. You can use the Device List to open multiple

systems or cameras at once.

17.1.4 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them from the app.

To control PTZ cameras:

1.

2.

Tap the display area the PTZ camera is connected to.

Tap . to open PTZ controls.
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PTZ Controls

Live View

Live Display: Swipe to move the camera. Pinch to zoom in/out.

Focus: Tap to show focus controls.

Zoom: Tap to show zoom controls.

Iris: Tap to show iris controls.

Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the checkmark to goto the preset.

@ NOTE

You must set presets for the camera using the system’s local menus before you can use this feature.

oD

17.1.5 Viewing Snapshots and Videos with Local Files
If you have saved snapshots or videos using the app, you may open them with Local Files.

To access Local Files:

e Tap E to access the Menu, and then tap Local Files.
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Local Files Overview

5\ '|
2014212090483

Menu: Return to Menu.

Files: Tap to open files.

File Type: Tap the options to select video files or snapshots.
Options: Tap to delete or export files to your device’s local storage.

rPON

|_§P| NOTE

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4
format.

17.1.6 Using Playback Mode on iPhone

You can access recorded video on your system using your iPhone.

@ NOTE

You must enable Sub Stream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. Tap E to access the Menu, and then tap Playback.

2. Tap + and select a channel to playback.

Live Preview
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3. Select the date then the start and end times to playback.
4. Use the on-screen controls to control playback.

Playback Controls

4.1.
4.2.
4.3.
4.4.
4.5.
4.6.
4.7.
4.8.
4.9.

4.10.
4.11.
4.12.
4.13.

Display Area: Double-tap to open in full-screen.

Play/pause.

Time Bar: Tap inside the bar to fast forward or rewind.

Previous: Select previous video file.

Next: Select next video file.

Snapshot: Tap to take a snapshot from the selected camera.

Stop All: Stop playback on all channels.

Not supported.

Manual Record: Tap to start/stop recording to your mobile device’s local
storage.

Fast.

Slow.

Time Range: Tap to change the range of time shown in the time bar.
Next frame.

17.1.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when
one of your cameras detects motion. Once you have received a push notification, you can
select it to open live video or a snapshot attachment from the camera that detected motion.

#L.X400021; r.29578/29578; en-US 114



17

Connecting to your System Using Smartphone or Tablet Apps

@ NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap E to access the Menu, and then tap Push Config.

2. Tap the system you would like to configure.

Push Config
)| HD System
O mountainview

O 192.168.50.123
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3. Tap Motion Detect and then check each channel you would like to receive push notifi-

cations from.

< lakeside.myddns-flir.co...

Period(Day)
Push type
Motion Detect
5] Main Lobby Fireplace
Main Lobby South Door
Main Lobby West
Main Lobby East
Stairwell - East
] Stairwell - West
Upper Stairwell - East

Uppers Stairwell - West

4. Tap to save changes. You will now receive a notification when one of the selected

cameras detect motion.

17.1.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

@ NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

e Tap E to access the Menu, and then tap Event List.
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Event List Overview

Event List mg—2)

12-12 08:10:09 Motion Detect

Channel 11 lakeside.myddns-flir.c...

12-12 08:09:35 Motion Detect 3

Channel 10 lakeside.myddns-flir.c...

12-12 08:09:25 Motion Detect 3
Channel 10 lakeside.myddns-flir...

12-12 08:08:13 Motion Detect 3

Channel 9 lakeside.myddns-fli.com

3.

Events: Shows the details of each motion detection event. Tap the event to view the

video or snapshot.
Delete All: Tap to delete all events in the Event List.

@ NOTE

To delete a single event, swipe it to the left and then tap Delete.
Event List T

208:08:23 Motion Detect 5 | Delete

nel 9 lakesida:myddns-flir.com

9 12-1208:08:13 Motion Detect 3

Channel 9 lakeside.myddns-flir.com

View: Tap to view the video or snapshot for the selected event.

17.1.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring

up the group of cameras in Live View without having to individually select each camera.

To use Favorites:

1.
2.

Tap E to access the Menu, and then tap Favorites.

Tap a group to configure an existing group.

@ NOTE

Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap .
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4. Select the cameras you would like to add to the group. Tap to save changes.

High priority

HD System
| CAM5
] CAM2
o CAM3
o CAM4
| CAMS5
| CAM6
| CAM7
5 CAM 8
lakeside.myddns-fli.com

m3100

@ NOTE

To delete cameras that have been added to the group, select the group in the group list. Then, swipe
left and tap Delete.

To open Favorites in Live View:
1. Tap E to access the Menu, and then tap Live View.

2. Tap ., and then tap ’ to open the group.

Live View Live View

7D\
D

)
)

High priority

17.1.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap E to access the Menu, and then tap E-Map.
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3. Select a .jpg image on your mobile device.

4. Press . and select a camera. Drag the camera on the screen to place it on the
map. Repeat to add additional cameras.

Unnamed

5. Click . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

©=

1. Tap in Live View.
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2. Select the E-Map in the Device List.

< Device List

E-Map
Home
Device

HD System

mountainview

192.168.50.123

CONNECT(8)

3. Tap the camera or cameras to select and then tap Connect to open the cameras.

ll\
e
J
% : N
=R\ e
L

CONNECT

17.1.11 Device Manager

You can use Device List to add, delete, or edit your systems.

To access Device Manager:

e Tap E to access the Menu, and then tap Device Manager.

To edit a system:

1. Tap the system in Device Manager. Tap _

— Device Manager

HD System

3

2. Edit the connection details as needed.
3. Tap Connect to save changes and connect to the system.
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To delete a system:

1. Tap the system you would like to delete.

2. Tap . Tap OK to confirm.

Device Manager

HD System

17.1.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an op-
tional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:

* The device you are connecting to must be connected to the Internet.

¢ You must port forward the HTTP Port (default: 80) and Client port (35000) on your
router to the device’s local IP address.

¢ To ensure connectivity, it is highly recommended to register for a free DDNS domain to
use with your system.

e For more information on port forwarding and DDNS, visit
www.lorextechnology.com/support.

To add a device using an IP or DDNS address:

1. Tap then .

Live View

2. Configure the following:
2.1. Tap Register Mode and select IP/Domain.
2.2.  Name: Choose a name for your system of your choice.
2.3. Address: Enter the IP address or DDNS address of your system.
2.4. Client Port: Enter the Client Port (default: 35000).
2.5. User Name: Enter the system’s User Name (default: admin).
2.6. Password: Enter the system’s Password (default: 000000).

3. Tap Connect. You will be prompted to change the system password.

4. Enter a new 6 character password and tap OK. This password will be used to log on to
your system from now on.

5. The app opens in Live View and streams video from your cameras.
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17.2 iPad

FLIR Cloud™ is an iPad app that allows you to remotely view your system.

17.2.1 Prerequisites

¢ Connect your system to your router using an Ethernet cable (included).
¢ Make sure to upgrade your system to the latest firmware version. You must have
the latest firmware and mobile apps to connect to the system over the Internet.

@ NOTE

For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

@ NOTE

The app will ask for permission to send push notifications and to access Photos. It will only send notifi-
cations if you enable motion-activated push notifications in the Push Config menu. It needs access to
Photos to save snapshots and video flips to the local storage on your mobile device.

17.2.2 Connecting to your system on an iPad

1. Install FLIR Cloud™ for free from the App Store.

N
2. Tap onthe FLIR Cloud™ icon §;¢5 to start the app.

3. Tap ﬁ then .

4. Tap Device Manager.
5. Tap Add.

Configuration Device Manager

Device Manager

]
L]
|
e
w
£+
®

6. Configure the following:
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EXAMPLE

Setting New Device

Device Manage

Channel Config

Push Alarm Config

HD System

GIES

Device ID Inv89b142be6
fe!

Alarm out Config 35000

Favorites :__admin

cescee
Configuration

S&+®mF 404

Help

Playback

Start Live View

6.1. Tap Start Scanning and line up the QR code on the top of the system using
the camera on your device.
OR

Under Device ID, manually enter the Device ID printed on the label.

6.2. Name: Choose a name for your system of your choice.

6.3.  Client Port: Enter the Client Port (default: 35000).

6.4. User Name: Enter the system’s User Name (default: admin).

6.5. Password: Enter the system’s Password (default: 000000)

6.6. Channel Amount: Enter the number of channels your system has.

7. Tap Start Live View. You will be prompted to change the system password.

8. Enter a new 6 character password and tap OK. This password will be used to log on to
your system from now on.

9. The app opens in Live View and streams video from all connected cameras.

17.2.3 Live View Interface

You can use FLIR Cloud™ in landscape or portrait mode.
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Live View Overview

a0~

©oN®

| cam2

CAM 4

| LRI

Display area: Double-tap to open camera in full screen.

Favorites: Slide to select favorites.

Disconnect: Disconnect from all open cameras.

Add to favorites: Add the current view to favorites.

Shapshot: Tap to take a snapshot from the currently selected channel.

@ NOTE

You can view or share snapshots using the Photos app.

Change display view.

Not supported.

Manual record: Tap to start/stop manual recording from this channel.
Not supported.

10. Open menus.
11. Select different camera.

17.2.4 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the app.

To control PTZ cameras:
1.

In Live View, tap the window the PTZ camera is connected to.
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2. Slide the middle controls to the right to access PTZ controls.

. B 201410245 3 1RM Fri

.' e ” —————r
IPPTZ Dome { —n .
© 0 6
= - ~y @DT7
= = & 0"

Live display: Swipe to move the camera. Pinch to zoom in/out.

Direction buttons: Tap to move the camera.

Zoom: Tap to zoom the camera in/out.

Focus: Tap +/- to adjust the focus.

Iris: Tap +/- to adjust the iris.

PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control
PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.
Goto preset: Tap to goto a camera preset.

@ NOTE

You must set presets for the camera using the system’s local menus before you can use this feature.

o0 k0N~

N

17.2.5 Using Playback Mode on iPad

You can access recorded video on your system using your iPad.

#L.X400021; r.29578/29578; en-US 125



17

Connecting to your System Using Smartphone or Tablet Apps

E note

You must enable Substream Recording to use playback mode on mobile devices.

To use Playback Mode:

({\‘
1. From Live View tap E then .

2. In Portrait Mode: Tap +, select the start time and end time for your search, and select
the camera you would like to playback.
OR

In Landscape Mode: Select the start time and end time for your search, and drag the
camera you would like to playback to the display area.

3. Use the playback controls.
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Playback Controls

Display area: Double-tap to open camera in full screen.
Play/pause.

Previous file.

Disconnect: Disconnect from the currently selected camera.

Not supported.

Snapshot: Tap to take a snapshot from the currently selected camera.
Change display view.

Menu.

. Next file.

10. Time range: Tap to change the range of time shown in the time bar.
11. Time Bar: Tap inside the bar to fast forward or rewind.

©CoNO~LND

@ NOTE

Playback controls are only shown in portrait mode.

17.2.6 Using Local File to View Manual Recordings
You can view manual recordings saved to your mobile device using the Local File menu.

To view manual recordings:

1. From live view, tap ﬁ then .
2. Tap Local Files.
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3. Tap avideo file to openiit.

Configuration Local File

Device Manager
Channel Config
Push Config
Local File

Relay out Config
Favorites

Local Config

o
||
+
<
0

Help

To delete videos:
1. Tap Edit.

2. Select the videos you would like to delete and tap .

17.2.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when
one of your cameras detects motion. Once you have received a push notification, you can
select it to open video or an image from the camera that detected motion.
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> FLIR Cloud

FLIR Cloud

FLIR Cloud
HD_System

@ NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. From live view, tap W then

2. Tap Push Config.
3. Tap the slider for the system you would like to configure.

Configuration Push Config

=2l
Device Manager HD_System

Channel Config
Push Config
Local File

Relay out Config
Favorites

Local Config

Jt+®™F 8ok

Help
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4. Tap Motion Detect then check each channel you would like to receive push notifica-

tions from.

Configuration

Device Manager

Channel Config

HD_System

~ Video motion

Push Config

Local File

Relay out Config

Favorites

Local Config

Help

Front

CAM 2

CAM 3

CAM 4

CAM 5

CAM 6

CAM 7

CAM 8

> Video Blind

Period: Days
@

5. Under Type, select Playback to attach a video file with each push notification. Or, se-
lect Picture to attach a still image of the camera that detected motion.
6. Tap OK to save changes. Whenever the selected cameras detect motion, you will re-

ceive a notification.

17.2.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push

notifications.

@ NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

1. From live view, tap ﬁ then .

Alarm event

03-25 14:43:29 Motion Detect Channel 3
03-25 14:43:19 Motion Detect Channel 3
03-21 16:04:42 Motion Detect Channel 1
03-21 16:04:16 Motion Detect Channel 1
03-21 16:03:59 Motion Detect Channel 1
03-21 16:02:08 Motion Detect Channel 1
03-21 16:01:29 Motion Detect Channel 1

03-21 15:59:06 Motion Detect Channel 1

03-21 15:58:23 Motion Detect Channel 1

nvrian

nvrlan

nvr

nvr

nvr
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17.2.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring
up the group of cameras in Live View without having to individually select each camera.

To create favorites:

A

1. InLive View, tap . to save the cameras that are currently open as a favorite.
2. Enter a name for the favorite and tap OK.

To open favorites in Live View:

¢ In Live View, slide the dial to cycle through favorites.

To edit favorites:

1. From live view, tap ﬁ then .

2. Tap Favorites.
3. Tap the favorite you would like to edit.

4. Tap Edit.
5. Select the cameras you would like to include in the favorite and then tap Save.
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17.2.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. From live view, tap &

2. Tap Add.

3. Select a .jpg image file on your mobile device.

+ @

4. To edit the E-map:
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9

|
1

s

°

4.1. Select Image: Select a different image file to use for your E-Map.
4.2. Add Camera: Tap + to select cameras to add to your E-Map. Then drag the

camera to place it on the E-Map.
4.3. Delete E-Map.

5. When you are finished editing the E-Map, tap Save and enter a name for the E-Map to

save changes.
To open cameras using the E-Map:

1. Inlive view, tap + on an empty display window and select the E-Map.
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2. Tap a camera from the E-map to open.

17.2.11 Using the Device Manager
Device Manager allows you to manage your systems.

To access Device Manager:

1. From live view, tap ﬁ then .

2. Tap Device Manager.
To delete a system:

1. Tap the system to select it.

2. Tap @ Tap Yes to confirm.

Configuration Device Manager

Device Manager
Relay out Config
Favorites

Local Config

«
&)
*
>
@)

Help

To modify a system:

1. Tap a system to select.

2. Tap the system again to open the edit screen.

3. Update the connection details as needed and then tap Start Live View.
17.2.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an op-
tional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:
* The device you are connecting to must be connected to the Internet.
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¢ You must port forward the HTTP Port (default: 80) and Client port (default: 35000) on
your router to the device’s local IP address.

e To ensure connectivity, it is highly recommended to register for a free DDNS domain to
use with your system.

e For more information on port forwarding and DDNS, visit
www.lorextechnology.com/support.

To add a device using an IP or DDNS address:

1. Install FLIR Cloud™ for free from the App Store.

N
2. Tap onthe FLIR Cloud™ icon gfb to start the app.

3. Tap ﬁ then .

4. Tap Device Manager.
5. Tap Add.

6. Configure the following:

6.1. Tap Register Mode and select IP/Domain. Then tap New Device to return to
the New Device screen.

6.2. Name: Choose a name for your system of your choice.

6.3. Address: Enter the DDNS or IP address of your device.

6.4. Client Port: Enter the Client Port (default: 35000).

6.5. User Name: Enter the system’s User Name (default: admin).

6.6. Password: Enter the system’s Password (default: 000000)

6.7. Channel Amount: Enter the number of channels your system has.

7. Tap Start Live View. You will be prompted to change the system password.

8. Enter a new 6 character password and tap OK. This password will be used to log on
to your system from now on.

9. The app opens in Live View and streams video from all connected cameras.
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17.3 Android

FLIR Cloud™ allows you to remotely view your system on Android devices.

17.3.1 Prerequisites

Connect your system to your router using an Ethernet cable (included).
Make sure to upgrade your system to the latest firmware version. You must have
the latest firmware and mobile apps to connect to the system over the Internet.

@ NOTE

For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

17.3.2 Connecting to your System on Android

1.

w N

>

6.

Download FLIR Cloud™ for free from the Google Play Store.

N
. Tap on the FLIR Cloud™ icon () to start the app.

Tap Sign up and enter your email address and password to create a new account.

Tap then .

Live View

. Configure the following:

EXAMPLE

o Password:

Live View.

Playback

CONNECT

5.1. Tap Scan QR Code and line up the QR code on the top of your system using
the camera on your mobile device.
OR

Under Device ID, manually enter the Device ID printed on the label.

5.2. Name: Choose a name for your system of your choice.

5.3. Client Port: Enter the Client Port (default: 35000).

5.4. User Name: Enter the system’s Username (default: admin).
5.5. Password: Enter the system’s Password (default: 000000).

Tap Connect. You will be prompted to change the system password.
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7. Enter a new 6 character password and tap OK. This password will be used to log on to
your system from now on.

Current password unsecured,
please change password

8. The app opens in Live View and streams video from your cameras.

17.3.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

Live View Overview

mountainview-

1. Menu: Tap to bring up the Menu.

2. Display Area: Double-tap to open a channel in full screen. Swipe left or right to select
a different page of channels.

3. Pages: Shows the number of pages available and highlights the currently selected
page.

4. Split: Select the split-screen layout.

5. Snapshot: Tap to take a snapshot from the currently selected channel.

6. Control Bar: Contains the following options. Swipe left or right to access more options.

6.1. Quick Playback: Tap to start/stop quick playback.
6.2. PTZ Controls: Open/close PTZ controls. PTZ camera required (not included).
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6.3. Streaming Quality: Open/close streaming quality panel.

6.4. Not supported.

6.5. Not supported.

6.6. Not supported.

6.7. Digital Zoom: Tap to activate digital zoom mode. Pinch to zoom in/out.

6.8. Color Settings: Tap to access color controls for the currently selected camera.

7. Manual record: Tap to start/stop manual recording.

8. Access Favorites.

9. Connect/disconnect all: Connect to/disconnect from all previously added cameras.

10. Device List: Tap to open a list of devices. You can use the Device List to open multiple
systems or cameras at once.

17.3.4 Controlling PTZ Cameras
If you have PTZ cameras (not included), you can control them from the app.
To control PTZ cameras:

1. Tap the display area the PTZ camera is connected to.

2. Tap . to open PTZ controls.
PTZ Controls

Live View

Rl |

Live Display: Swipe to move the camera. Pinch to zoom in/out.

Focus: Tap to show focus controls.

Zoom: Tap to show zoom controls.

Iris: Tap to show iris controls.

Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the checkmark to goto the preset.

@ NOTE

You must set presets for the camera using the system’s local menus before you can use this feature.

o0~
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17.3.5 Viewing Snapshots and Videos with Local Files

If you have saved snapshots or videos using the app, you may open them with Local Files.
To access Local Files:

e Tap E to access the Menu, and then tap Local Files.

7 20140401 152437 Fo0 20140401 152431

Menu: Return to Menu.

Files: Tap to open files.

File Type: Tap the options to select video files or snapshots.

Options: Tap to share, delete, or export files to your device’s local storage.

|_§P| NOTE

Exported video files are saved to MP4 format in the folder /snapshot/mp4/, which you can access
by connecting your Android device to a computer using a USB cable.

rPOD

17.3.6 Using Playback Mode on Android

You can access recorded video on your system using your Android.

@ NOTE

You must enable Sub Stream Recording to use playback mode on mobile devices. For details on enabling
Sub Stream Recording, see 10.3 Setting up Scheduled or Manual Recording, page 24.

To use Playback Mode:

1. Tap E to access the Menu, and then tap Playback.
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2. Tap + and select a channel to playback.

Live Preview

3. Select the date then the start and end times to playback.
4. Use the on-screen controls to control playback.

Playback Controls

41.
4.2.
4.3.
4.4.
4.5.
4.6.
4.7.
4.8.
4.9.

4.10.
4.11.
4.12.
4.13.

Display Area: Double-tap to open in full-screen.

Play/pause.

Time Bar: Tap inside the bar to fast forward or rewind.

Previous: Select previous video file.

Next: Select next video file.

Snapshot: Tap to take a snapshot from the selected camera.

Stop All: Stop playback on all channels.

Not supported.

Manual Record: Tap to start/stop recording to your mobile device’s local
storage.

Fast.

Slow.

Time Range: Tap to change the range of time shown in the time bar.
Next frame.
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17.3.7 Enabling Push Notifications

You can have the app send push natifications to the notifications area on your device when
one of your cameras detects motion. Once you have received a push notification, you can

select it to open live video or a snapshot attachment from the camera that detected motion.

9:51
Cc) 2014-04-02

@ NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap E to access the Menu, and then tap Push Config.

2. Tap the system you would like to configure.

— Push Config
©) HD System
( "i‘ mountainview

)J 192.168.50.123
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3. Tap Motion Detect and then check each channel you would like to receive push notifi-
cations from.

< HD System

Period(Day)

Push type

Motion Detect

)} CAM 5

(7.1 3

) CAM 3

CAM 4

) CAM 5

D) CAM6

©) cam7

4. Under Push type, select Video to attach a video clip to each push notification. Or, se-
lect Image to attach an image to each push notification.

5. Tap to save changes. You will now receive a notification when one of the selected
cameras detect motion.

17.3.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

@ NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

e Tap E to access the Menu, and then tap Event List.
Event List Overview

Event List

—— 12-1110:14:17 Motion Detect
HD System - Channel 1

12-1110:13:12  Motion Detect
HD System - Channel 1

12-1110:12:31  Motion Detect
HD System - Channel 1

1. Events: Shows the details of each motion detection event. Long press an event to de-
lete just that event.

2. Delete All: Tap to delete all events in the Event List.

3. View: Tap to view the video or snapshot for the selected event.

17.3.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring
up the group of cameras in Live View without having to individually select each camera.

To use Favorites:
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1. Tap E to access the Menu, and then tap Favorites.

2. Tap a group to configure an existing group.

@ NOTE

s
Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap .

4. Select the cameras you would like to add to the group. Tap to save changes.

High priority

> HD System

] cAMS5

| CAM2

| CAM3

O cama

) CAMS

] cam6

) cAM7

) cAM8
mountainview

192.168.50.123

E note

and hold to delete cameras from the group.

To delete cameras that have been added to the group, select the group in the group list. Then, press

To open Favorites in Live View:
1. Tap E to access the Menu, and then tap Live View.

2. Tap . and then tap } to open the group.

Live View Live View

72
NP

High priority
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17.3.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap E to access the Menu, and then tap E-Map.

2. Tap .

3. Select a .jpg image on your mobile device.

4. Press _ and select a camera. Drag the camera on the screen to place it on the
map. Repeat to add additional cameras.

Unnamed

5. Click . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

1. Tap in Live View.
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2. Select the E-Map in the Device List.

< Device List

E-Map
Home
Device

HD System

mountainview

192.168.50.123

CONNECT(8)

3. Tap the camera or cameras to select and then tap Connect to open the cameras.

CONNECT

17.3.11 Device Manager

You can use Device List to add, delete, or edit your systems.

To access Device Manager:

e Tap E to access the Menu, and then tap Device Manager.

To edit a system:
1. Tap the system in Device Manager. Tap .

Device Manager

HD System

2. Edit the connection details as needed.
3. Tap Connect to save changes and connect to the system.
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To delete a system:

1. Tap the system you would like to delete.

2. Tap . Tap OK to confirm.

Device Manager

HD System

17.3.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an op-
tional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:

* The device you are connecting to must be connected to the Internet.

¢ You must port forward the HTTP Port (default: 80) and Client port (default: 35000) on
your router to the device’s local IP address.

¢ To ensure connectivity, it is highly recommended to register for a free DDNS domain to
use with your system.

e For more information on port forwarding and DDNS, visit
www.lorextechnology.com/support.

To add a device using an IP or DDNS address:

1. Tap then .

Live View

2. Configure the following:

2.1. Tap Register Mode and select IP/Domain.

2.2.  Name: Choose a name for your system of your choice.

2.3. Address: Enter the IP address or DDNS address of your device.
2.4. Client Port: Enter the Client Port (default: 35000).

2.5. Username: Enter the system’s User Name (default: admin).
2.6. Password: Enter the system’s Password (default: 000000).

3. Tap Connect. You will be prompted to change the system password.
4. Enter a new 6 character password and tap OK. This password will be used to log on to
your system from now on.

Current password unsecured,
please change password

5. The app opens in Live View and streams video from your cameras.
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Free DDNS service is available as an optional connectivity method to connect to your sys-
tem over the Internet.

@ NOTE

Except where noted, the instructions in this section are the same on PC or Mac.

18.1 Accessing your System within a Local Network (LAN)

You can connect to your system through using the Client Software through the local area
network (LAN). It is recommended to confirm connectivity over a local network before set-
ting up your system for DDNS connectivity.

@ NOTE

To complete the steps below, your computer must be on the same network as your system.

18.1.1 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.

2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system.
Connect the other end of the Ethernet cable to an empty LAN port (usually numbered
1~4) on your router.
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3. Reconnect the power adapter to power the system back on.

BT .

Security System
(may not be exactly as
shown)

Internet Router Computer

(not required for
local viewing)

18.1.2 Step 2 of 3: Obtain the System’s Local IP Address

1. Right-click to open the Quick Menu and click Info. Enter the system user name (de-
fault: admin) and password (default: 000000).

dht3ce94b016

2. Write down the IP Address of the system.
* Alocal IP looks something like this: 192.168.5.118.

18.1.3 Step 3 of 3: Connect to the System’s Local IP Address

Follow the steps below to confirm connectivity over a local network on a PC or Mac.
To connect using the system’s local IP address:

1. Download and install the client software.

¢ PC Users: Download and install the Client Software for PC from
www.lorextechnology.com/support.

e Mac Users: Download and install the Client Software for Mac from
www.lorextechnology.com/support. Double click to extract the software. Drag the
software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (ch) from the
desktop or Applications list.
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3. Log into the Client Software using the Client Software user name (default: admin) and
password (default: admin) and then click Login.

4. The client scans your LAN for connected systems. Check your system (a) and click
Add (b).

5. Enter the password for your system (default: 000000) and click OK.
6. If this is the first time you are connecting, you will be prompted to change the system
password.

Information
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7. Enter a new 6 character password and click OK. This password will be used to con-
nect to your system from now on.

Please update your system's password.

[

8. Click - then .

9. Click and drag Default Group to the display window to open your cameras in live view.

Result

{Bront

18.2 DDNS Setup—Access your System Remotely over the Internet

Setting up DDNS connectivity allows you to view your system from any computer or com-
patible mobile device with Internet access.
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To set up remote connectivity with your system, you must:

1.

2.

3.
4. Test the remote connection by entering your DDNS address in the client software.

Port forward the HTTP port (default: 80) and Client port (default: 35000) on your router
to your system’s IP address.

Create a DDNS account.

Enable DDNS on the system.

18.2.1 Step 1 of 4: Port Forwarding

You must port forward the HTTP port (default: 80) and Client port (default: 35000) on your
router to your system’s IP address before you can remotely connect to your system. There
are several methods to port forward your router:

Use the Auto Port Forwarding Wizard (PC only) to port forward the required ports
(see www.lorextechnology.com for details). For instructions, see the Auto Port Forward
Wizard manual on www.lorextechnology.com.

Manually port forward the required ports on your router to your system’s IP address by

following your router manufacturer’s instructions. For more information on port forward-

ing, see the reference guides on www.lorextechnology.com.

@ NOTE

If the above ports are not forwarded on your router, you will not be able to access your system remotely.

18.2.2 Step 3 of 4: Enable DDNS on the System

To enable DDNS in your System:

1.

Right-click and click Main Menu. Enter the system password if prompted.

Click “ and then click Network>DDNS.

Check Enable.

Under Domain Name, enter the Domain Name/URL Request your received in the
email after registering for DDNS.

Under User Name, enter your DDNS User Name.

Under Password, enter your DDNS Device password.

Click OK to save your settings.

@ NOTE

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before at-
tempting to connect.

18.2.3 Step 4 of 4: Connect to the System’s DDNS Address

@ NOTE

tempting to connect.

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before at-

To connect using the system’s DDNS address:
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1. Download and install the client software on a remote computer.

¢ PC Users: Download and install the Client Software for PC from
www.lorextechnology.com/support.

e Mac Users: Download and install the Client Software for Mac from
www.lorextechnology.com/support. Double click to extract the software. Drag the
software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (@5) from the
desktop.

3. Log into the Client Software using the Client Software user name (default: admin) and
password (default: admin) and then click Login.

4. Click Add Device.

SFLIR

HOME PAGE

5. Enter the following:

5.1. Check By IP/Domain to add a system using the DDNS address.

5.2. Device Name: Choose a name for your system of your choice.

5.3. IP/DDNS Address: Enter the Domain Name/URL Request you received in the
email when you registered for DDNS followed by .lorexddns.net.

@ NOTE

For example, if your Domain Name/URL Request is tomsmith, enter tomsmith.lorexddns.net

5.4. Client Port: Enter the Client Port (default: 35000).
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5.5. User Name: Enter the system User Name (default: admin).
5.6. Password: Enter the system Password (default: 000000).

6. Click Add. If this is the first time you are connecting, you will be prompted to change
the system password.

nformation

7. Enter a new 6 character password and click OK. This password will be used to con-
nect to your system from now on.

Please update your system's password.

L

8. Click - then .

9. Click and drag Default Group to the display window to open your cameras in live view.

SEEsEODEEE =

#L.X400021; r.29578/29578; en-US 153



18

DDNS Setup (Advanced)

Congratulations! You can now connect over the Internet to view and playback video on
your computer.
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Connecting a PTZ Camera
(LNR400 Series)

You can connect PTZ cameras (not included) to the system. You must use Lorex IP PTZ
cameras with the system. Lorex IP PTZ cameras can accept PTZ commands directly
through the Ethernet cable. There is no need to run special wiring to use PTZ cameras.

To connect a PTZ camera to the system:

1. Connect the camera video cable to one of the Video IN ports on the system.
2. Right-click and click Main Menu. Enter the system user name (default: admin) and
password (default: 000000) if prompted.

3. Click“>5etting>Pan/TiItlZoom.

GENERAL
DISPLAY.

RS232
PANTILTIZOOM
ACCOUNT

Al

Remote

Config Backup
DEFAULT
UPGRADE

4. Under Channel, select the channel your PTZ camera is connected to.
5. Under PTZ Type, select Remote.
6. Click OK. You can now control your PTZ camera using the system.

19.1 Controlling a PTZ Camera (Local NVR)

1. In Live View, double-click the channel that has the PTZ camera connected to open in
full-screen.

2. Right-click and click PTZ. Enter the system user name and password if prompted. The
PTZ menu opens.

3. Use the on-screen PTZ controls to control the camera.
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PTZ Controls

—_

Direction keys: Click to pan and tilt the camera. Click SIT to stop the current action.
2. Mouse PTZ: Click to activate mouse PTZ mode. In mouse PTZ mode:

* Click and drag to move the camera.
* Use the scroll wheel to zoom in and out.
¢ Right-click to exit and return to normal PTZ controls.

3. Zoom/Focus/Iris: Click +/- to adjust the zoom, focus, and iris.
4. Advanced controls: Click to open advanced PTZ controls.
5. Speed: Enter the PTZ speed.

19.2 Advanced PTZ Controls

Advanced PTZ controls can be used to save camera positions and cycle through various
positions, and automate camera actions.

To open advanced PTZ controls:

* Click the arrow in the PTZ control window to open advanced controls.

Speed 5

® Zoom
® Focus €
@ Iis @

—_

No.: Select the number of the action you want to perform.

2. Not supported.

3. PTZ camera menu: Click to open the camera’s OSD menu. This may not be sup-
ported on all camera models.

4. Preset: Click to call the selected preset.
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o

Autopan: Click to start autopan. During autopan, the camera will continuously pan
360°.

Tour: Click to run the selected tour.

Flip: Click to flip the camera 180°.

Reset: Click to move the camera to the home position.

. Pattern: Click to run the selected pattern.

10. Auto scan: Click to run the selected autoscan.

11. Aux: Click to open the aux menu, where you can set up Presets, Tours, Patterns, and
Auto Scans.

©oN®

19.2.1 Presets
Presets will save a camera position for quick retrieval.

To add presets:

1. Click to open the aux menu.
2. Click the Preset tab.

I, - TITIZOON A

Preset Tour Pattern Border

Preset il

3. Enter the number of the preset you want to create under Preset.
4. Move the camera to the desired position and click Set.

To go to a preset:

* Under No., select the number of the preset you would like to go to and click @

19.2.2 Tours
Tours will cycle through a set of presets.

To create a tour:

1. Click to open the aux menu.
2. Click the Tour tab.

PAN/TILT/ZO0OM

Tour Pattern Border

Preset 1
Patrol No. (0

Add Preset
Del Preset
Del Tour

3. Under Patrol No., select the tour you would like to configure.
4. Under Preset, select a preset you would like to add to the tour.
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5. Click Add Preset.
6. Repeat steps 4 and 5 to add additional presets to the tour.

@ NOTE

Click Del Tour to clear all presets from a tour.

To run a tour:
¢ Under No., select the number of the tour you would like to go to and click @

19.2.3 Pattern
Patterns automatically cycle the camera between two positions.

To create a pattern:

1. Click to open the aux menu.
2. Click the Pattern tab.

PANTILT/ZOOM

Preset Tour Pattern Border

Pattern 1

Begin
End

3. Under Pattern, enter the pattern you would like to configure.
4. Move the camera into the desired start position and click Begin.
5. Move the camera into the desired end position and click End.

To run a pattern:

* Under No., select the number of the pattern you would like to go to and click E’]

19.2.4 Auto Scan
An auto scan automatically cycles between a left and right point.

To create a new auto scan:

1. Click to open the aux menu.
2. Click the Border tab.

PANITILT/ZOOM

Preset Tour Pattern Border

Left
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3. Move the camera into the desired left position and click Left.
4. Move the camera into the desired right position and click Right.

To run an auto scan:

* Click .

#L.X400021; r.29578/29578; en-US

159



20

LNR400 Series Hard Drive
Installation

The system comes with a pre-installed 3.5" SATA hard drive. You can install up to two hard
drives up to a maximum size of 4TB each.

20.1 Installing a Hard Drive

/\  cauTion

Make sure that the system is OFF and the power cable is disconnected before removing/installing the
hard drive.

To install the hard drive:

1. Insert hard drive screws (4x) on the hard drive and tighten them half way.

2. Power off the system, and unplug all cabling from the system.
3. Remove the rear panel screws (4x). Remove the cover.

4. Place the hard drive over one of the sets of screw slots on the bottom of the system
and then slide the hard drive into place. The SATA connectors on the hard drive should
face the center of the unit.

i
ey
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5. Turn the system over carefully. Tighten the hard drive screws (4x) to secure the hard
drive.

/A  caution

Hold the hard drive in place when turning the system over to prevent damage to the system.

6. Connect the SATA power and data cable to the hard drive.

7. Replace the cover and cover screws (4x).

@ NOTE

After installation, you must format the hard drive in order to use it with the system. See 20.3 Format-
ting Hard Drives, page 162.

20.2 Removing the Hard Drive

/\  caution

Make sure that the system is OFF and ALL power adapters have been disconnected before removing/in-
stalling the hard drive.

1. Power off the system, and unplug all cabling from the system.
2. Remove the rear panel screws (4x). Remove the cover.
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LNR400 Series Hard Drive Installation

3. Turn the system over and loosen the hard drive screws (4x), but do not remove them.

6. Replace the cover and cover screws (4x).

@ NOTE

After installation, you must format the hard drive in order to use it with the system. See 20.3 Format-
ting Hard Drives, page 162.

20.3 Formatting Hard Drives

You must format hard drives before you may use them with the system.
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LNR400 Series Hard Drive Installation

/\  cauTion

Formatting the HDD erases all data on the hard disk. This step cannot be undone. System settings will

not be erased.

To format the hard drive:

1. From the Main Menu, click“ and then click Storage>HDD Manager.

SCHEDULE
HDD MANAGER
RECORD

Type
Read-write HDD

Refresh Format

2. Select the hard dive you would like to format and then click Format. Click OK to
confirm.

3. Click OK to save changes. The system will restart to complete the formatting process.
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Recording Audio

The system can record audio on any channels that have audio-capable cameras con-
nected to them. You must have an audio-capable camera (not included) in order to record
audio using the system. The camera must have a built-in microphone or an audio input ca-
ble (for example RCA) for connecting a self-powered microphone.

@ NOTE

The MIC IN/OUT ports on the rear panel of the system are not supported and cannot be used for audio
recording.

Audio recording without consent is illegal in certain jurisdictions. Lorex Technology Inc. assumes no liabil-
ity for use of its products that does not confirm with local laws.

21.1 Step 1 of 2: Connecting an audio-capable camera

Connect the camera to the NVR or network. If the camera is connected to the network,
add it to the NVR. For details, see 6.11 Connecting Cameras to the Local Area Network
(LAN), page 13.

Option A: Connect a camera with a built-in microphone.

NVR (may not be exactly as shown)

Camera with built-in microphone

\ Ethemnet cable
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Recording Audio

Option B: Connect a camera with audio input.

NVR (may not be exactly as shown)

Camera with audio input

\ Ethernet cable

@ NOTE

The microphone must have its own power source.

21.2 Step 2 of 2: Configuring audio recording

1. Right-click and click Main Menu. Enter the system user name (default: admin) and
password (default: 000000) if prompted.

2. Click w2 and select Recording>Recording.

RECORDING
SNAPSHOT

960x480(960H -

30
CBR

Bit Rate(Kbps)

Reference Bit

3. Under Channel, select the channel where the audio-capable camera is connected.

4. Under Audio/Video, check the box on the left to enable audio recording.

5. Under Audio Encode, select the format that will be used to record audio. G711ais
recommended.

6. Click OK to save changes.
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Troubleshooting

When a malfunction occurs, it may not be serious and can be corrected easily. The follow-
ing describes the most common problems and solutions. Please refer to the following be-

fore calling Lorex Technical Support:

Error Possible Causes Solutions
* System is not receiving ¢ Cable from power adapter is Confirm that all cables are
power, or is not powering up. loose or is unplugged. connected correctly.

Confirm that the power
adapter is securely con-
nected to the back of the unit.

* Power switch is set to OFF (

. ) position.

Confirm that the power switch
is in the ON (I) position.

e Cables are connected, but
system is not receiving suffi-
cient power.

Confirm that the system is
powered on (LED indicators
on the front should be ON).

If the unit is connected
through a power bar or surge
protector, try bypassing the
bar and connecting the
power directly to the wall
outlet.

Confirm that there is power at
the outlet:

¢ Connect the power cable
to another outlet.

¢ Test the outlet with anoth-
er device (such as a lamp
or phone charger).

e Hard drive is not detected by | ¢ Hard drive cables are loose
the system. or not properly connected.

Remove the housing and
check that hard drive cables
are firmly connected.

e There is no hard drive in the

Open the housing and install

system. compatible hard drive. Make
sure to format the drive after
installing. For details, see .
e Hard drive is full (0%) and ¢ Overwrite is not enabled. From the Main Menu, select
the unit is no longer
recording. >Setting>Gener-
al>General. Select Overwrite
under HDD Full and click OK.
* There is no picture on moni- ¢ Monitor/TV not detected by Power off the monitor/TV and
tor/TV after connecting it to system. system. Power on the moni-
the system. tor/TV, and then power on the

system.

¢ Input channel for system not
selected on monitor/TV.

On the monitor/TV, select the
input channel the system is
connected to.

* Video cable is loose or has
become disconnected.

Check the video cable con-
nection to the system and
monitor/TV.
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Troubleshooting

Error

Possible Causes

Solutions

¢ Mouse not detected by
system.

* Mouse cable is not firmly
connected to the system.
Mouse is not connected to
the system.

¢ Firmly connect the mouse ca-
ble to one of the USB ports.

¢ System needs to be reset

¢ Power off the system (discon-
nect power cable). Firmly
connect a USB mouse to one
of the USB ports. Reconnect
the power cable to the DC
12V port on the rear panel.

* There is no picture on se-
lected channels / camera

picture is not being displayed.

e Camera cables are loose or
have become disconnected.

¢ Check the camera video ca-
ble and connections.

¢ Disconnect and reconnect
the cable at the system and
at the camera.

¢ Try moving the camera to an-
other channel or use another
cable.

* The system beeps at startup.

e The beep at startup is normal.

* The system beeps during
motion detection.

* Motion detection is enabled
and the alarm buzzer is
activated.

¢ Open the Main Menu and

click >Event>Mo-
tion>Motion Detect. Uncheck
Buzzer for each channel and

click Apply.

* | am not receiving email
notifications.

¢ Email notification is disabled.

* Ensure you have configured
email notification. For details,
see 14.3.5 Configuring Email
Alerts, page 55.

¢ Send Email setting not en-
abled in Event menu.

¢ Make sure that Send Email is
enabled for any events you
want to be notified of.
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LNR400 Series System

Specifications

23.1 System

Operating System

Embedded LINUX

Pentaplex

Simultaneous View, Record, Playback, Backup,
and Remote Monitoring

Number of Channels

8/16 Channels

23.2 Inputs/Outputs

Video IN 8/16 ch: 8 PoE Video Input

Video OUT No

VGA OUT Yes

HDMI Yes

Audio IN 1 Line IN (RCA) for service only
Audio OUT 1 Line OUT (RCA) for service only
USB Port 1 at the back, 1 at the front

Alarm IN 8 Alarm IN

Alarm OUT 3 Alarm OUT

Video Output Resolution

1920x1080, 1280x1024, 1280x720, 1024x768

PTZ Control Lorex IP PTZ cameras only
23.3 Display
Display Split 8 ch: 1/4/8/9
16 ch: 1/4/8/9/16
Live Display Speed 8 ch: 240FPS NTSC, 200 PAL
16 ch: 480FPS NTSC, 400 PAL
OSD Camera Title, Time, Camera Lock, Motion Detec-

tion, Recording Status

System Navigation

USB mouse, IR remote control, front panel buttons

Motion Area Setting

Adjustable grid (22x18)

Sensitivity Levels

100

Firmware Upgrade

Automatic over the Internet & via USB device and
network

User Authority

By user group

Time Synchronization

Auto time sync by NTP server

23.4 Recording

Compression

H.264

Resolution

1080P (1920x1080) / 720P (1280x720)
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LNR400 Series System Specifications

Record Rate

NTSC

8 ch: 240FPS @ 1080p
16 ch: 480FPS @ 1080p
PAL

8 ch: 200FPS @ 1080p
16 ch: 400FPS @ 1080p

Recording Resolution Setting

Per camera for different resolutions

Recording Quality Control

6 levels

Record Schedule

By hour, by day, by recording mode, by motion, by
channel

Pre Recording

Max. 30 Seconds

Post Recording

Max. 5 Minutes

Reliability Watch-Dog, auto-recovery after power failure
Covert Video Yes
23.5 Playback and Backup

Playback Channel 8 ch: 1/4/9
16 ch: 1/4/9/16

Playback Speed Variable Max 16x

Playback Players Backup Player

Search By time & event

Log Search Up to 1,000 lines for motion detected, configura-
tion changes, connects/disconnects and video
loss

Audio Play Yes (audio camera required)

23.6 Storage & Archive

Storage

8/16 ch: Up to 2 HDD’s (SATA)

Maximum Capacity

8/16 ch: Up to 2x4TB

Backup Media

USB flash drive & HDD

Backup File Format

DAV or ASF file

23.7 Connectivity

Cloud Connection FLIR Cloud™
Supported Operating Systems Windows™
Mac OSX

Remote Software

Client Software (PC/Mac)

Email Notification

Text with snapshot

Instant Smart Phone & Tablet Support

iPad®, iPhone®, Android™

DDNS

Free Lorex DDNS

System Configuration

Full setup configuration over network

Ports

Programmable by user
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Network Protocol

HTTP, IPv4/IPv6, TCP/IP, UPNP, RTSP, UDP,
SMTP, NTP, DHCP, DNS, PPPOE, DDNS, FTP, IP
Filter

Network Interface

10/100/1000Mbps, RJ-45

Network Bit Rate

256Mbs total
48~8192kbps per camera

23.8 General

Power Consumption

Approx. 20 watts (No HDD Installed)

Supply Voltage

100VAC-240VAC, 50/60Hz

Total PoE Power Output (across all channels)

120W (Max 25W per Camera)

Unit Weight

2.3kg/5.1lbs

Dimensions (W x H x D)

375mm x 285mm x 50mm/ 14.7” x 11.2” x 2.0”

Operating Temperature

14°~131°F/-10°~55°C

Humidity

10 ~90% RH

23.9 Recording Resolution (Pixels) & Speed (FPS — Frames per second)

720P 1080P
Model FPS
1280x720 1920x1080
Total 240 240
8ch
Per channel 30 30
Total 480 480
16¢ch
Per channel 30 30

As our products are subject to continuous improvement, Lorex Corporation and its subsid-
iaries reserve the right to modify product design, specifications, and prices without notice

and without incurring any obligation. E&OE
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Notices

This product has been certified and found to comply with the limits regulated by FCC,
EMC, and LVD. Therefore, it is designated to provide reasonable protection against inter-
ference and will not cause interference with other appliance usage. However, it is impera-
tive that the user follows the guidelines in this manual to avoid improper usage, which may
result in damage to the product, electrical shock and fire hazard injury.

24.1 FCC/IC Notice

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception (which can
be determined by turning the equipment on and off), the user is encouraged to try to cor-
rect the interference by one or more of the following measures:

1. Reorient or relocate the receiving antenna.

2. Increase the separation between the equipment and receiver.

3. Connect the equipment into an outlet on a circuit different from that to which the re-
ceiver is connected.

4. Consult the dealer or an experienced radio or television technician for assistance.

24.2 Modification

Any changes or modifications not expressly approved by the grantee of this device could
void the user's authority to operate the device.

Toute modification non approuvée explicitement par le fournisseur de licence de I'appareil
peut entrainer I'annulation du droit de I'utilsateur a utiliser I'appareil.

24.3 ROHS

This product is fully compliant with the European Union Restriction of the Use of Certain
Hazardous Substances in Electrical and Electronic Equipment ("RoHS") Directive (2002/
95/EC). The RoHS directive prohibits the sale of electronic equipment containing certain
hazardous substances such as lead, cadmium, mercury, and hexavalent chromium, PBB,
and PBDE in the European Union.
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